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This document explains the deployment steps for the Infoblox IPAM plugin for VMware vRealize
Automation (VRA) 7.3. The Infoblox IPAM Plug-in for VMware integrates automatic IP address
allocation and DNS registration capabilities into the VMware vCloud automation solutions.

User input Text is shown in bold.

Output is shown in italics.

This section provides the steps for configuring NIOS in preparation of installing the Infoblox IPAM
plugin for VMware.

Create the networks in NIOS which will be used for provisioning IP addresses. By default, the Infoblox
Plugin does DNS registration in the Zone specified in DHCP option Domain Name set in the DHCP
Options at the network and/or range level.

To create the networks which will be used for IP address assignment with the Infoblox plugin for
VMware:

1. Navigate to Data Management -> DHCP in your Grid Manager GUI.

Click on +. Select (IPv4) Network if you expanded the Add menu.

Select Add Network. Click Next.

Set the Netmask to the CIDR to be used for your network (e.g. 24, or 255.255.255.0).

Click + and type the address for your network (e.g. 172.26.1.0).

Click Next.

Click +. Select Add Infoblox Member if expanding the Add menu.

If you have a single server in your Infoblox Grid, this should be automatically selected for you.

Otherwise, follow the selector window to select the Grid member(s) to assign to the network.

9. Click Next and Next again until you are on the step to configure the options for the network (this
is step 5 of 7 in NIOS version 8.

10. Set the options required for clients to operate properly the network, such as any Routers (which
will be the clients default gateway), along with the Domain Name option. DNS records being
created for VM instances will be placed into this zone by default.

© NOoO A WN

Note: The plugin will not be able to read inherited options. The Domain Name option must be
overridden and set at the network and/or range levels; otherwise, updates from the plugin will fail.
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Add IPv4 Hetwork Wizard > Step 5 of 7

Lease Time |1 2 Hourzs ¥
Urlimited Lease Time
Inachvertently selecting the Unlimited Lease Time check box ar using this Override
option incarrectly could cause 5 serious netvwork outage inthe future when
all available leases are allocated
Inherted from Grid Infoblos
Routers
+ @
B Pagess Tert
(B 172161 1 L Srere
-
Domain Hame @ com
DHS Servers
L ] L
P &ddress
Override
1722612
Inherted from Grid Infoblox
Broadcast Address
Override
Inherted from Grid Infoblox
Cancel Previous Mext Schedule for Later Save & Close -

11.Click Next to configure Extensible Attributes (optional).
12.Click Save & Close.
13. Restart services.

3.2 Extensible Attributes Required for the vVRA Plugin

Additional Extensible Attributes (EA’s) are required in NIOS. These include the following EA’s, with the
type that they should be created as noted in parentheses (note: Only the name to be used for the EA is
in bold. The remaining information indicates the EA type, such as integer or string):

e VMware NIC index (integer)

e VMware resource ID (string)

e VMware On-Demand Network (string)

o VMware Network Profile (string)

e VMware External Network Profile ID (string)
¢ VMware External Range ID (string)

e VMware Request ID (string)

o VMware Blueprint Request ID (string)
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To create the required EA’s:

1. Navigate to Administration -> Extensible Attributes in your Infoblox Grid Manager GUI.

Dashboards Data Management Cloud Smart Folders Grid Administration Q‘Search

Extensible Attributes Cloud Avthenticatiol ] Mamed ACLs

Metwork Views

Administrators Whiork floe Logs

Extensible Attributes Tooiber
Guick Fitter | Mane | Show Filter o o
Commenit ELIFEs z DM Corvverter

[] Account String 20
[ nlleaticn T Thrira bl Hrst Rosoa s =]

2. Click on the + (Add) button.

3. Enter the name for the EA, as displayed in bold in the list above.

4. Setthe Type dropdown menu to the required setting (refer to the list above).

5. Optional: Add a comment

6. Click on the small arrow next to Save & Close and select Save & New to add additional EA’s,

or click on Save & Close if done.

Add Exten=ible Attribute Wizard > Step 1 of 2

Hame* “Muware resource D
Type String v
Humber of characters Min Max
Comment
Cancel Previous Pt Save & Close T

Host dgoreostes String Mo Save & Close
|B Dizcovery Cwened String Mo Save & Edit
IP Type Lizt Mo Save & Mew

Interfare hame Strinn Bl
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Dashboards Data Management Cloud Smart Folders Grid

Administration

Administrators ok Extensible Attributes Clowdd Authentication Server Groups

Extensible Attributes

Giick Fiter | Maone

v| | [on] Fitter ore
Neme v lbeanswin v lwwwe

| Hide Filter

Save..
=
* 5O RE
|u Mame - et ed Restrict
[] whiware Blueprint Reguest ID
[] whiware External Metwark Profile [0
|:| Whiweare External Range 1D String Mo
[] Whbware WIC index Irteqer T Incle Tl
[T] “hweare betweark Profile ID String Mo
[T] “hweare On-Demand Metweork String Mo
[] whiware Reguest ID String [
[] whiware resource 1D String Whiveare resource 1D Mo

3.3 Create Cloud API account

Using an administrator account which is a member of the cloudapi-only group (or similar group where
the Allowed Interfaces configuration is set to APl -> Cloud API -> Cloud API Only (No PAPI)) is
highly recommended as this allows the Infoblox IPAM plugin to send detailed Tenant information to
NIOS.

Create the Cloud API account. Here, we have created an account named cloudadmin and assigned it
to the default cloud-api-only group.

Administrators

Quick Fitter | Nane v | E3 Show Filter
Goto Go
|u Mame - GroLp Comment

[T admin acdmin-group

|:| cloudadmin cloud-api-anly
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Add Permissions to the Cloud API account. Initially, it may be advisable to set everything to be allowed
and then restrict these as required later on by removing permissions that are not needed. The
permissions should allow the operations that the Infoblox IPAM plugin will be performing, such as riw
for networks and zones and if setting object level permissions, for the networks and zones that it will be

updating.

Dashboards

Administrators

Addminz

Data Management

Winrkflowe

Groups

Cloud Smart Folders Grid Administration

Claud Authertica

Logs Metneork ie : Aftributes

Roles Permissions Avthertication Policy

Mamed ACLs

claudadmin

Groups Show All

PR cloud-api-only

cloud-api-only Permissions

Quick Filter wp

All Configured Permissions ¥

All Permizzion Types v

| W GroupRole CE Resource Type
|:| cloud-api-only DHE Permissions Al & Records A recard R
|:| cloud-api-only DMZ Permissions All AL LS Records AAAL record Ry
|:| cloud-api-only Administration Permissions All CA Cerificates 8 Cerificate Ry
Example showing the Allowed Interfaces configuration:
cloud-api-only (Admin Group)
General [J Superusers
| roes [ + 0
Templates n
Mo data

Approval L]

Hotifications

Exte_nsmle Allowed Interfaces

Attributes # cu

|« APl
APl (WAPLPAPI onby)
o Cloud AP1
(@), Cloud AP1 only (Ho PAPI)
loud APl and PAPI (Ho WAPI)}

Cancel Save & Cloze -
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Log on to VMware vRealize Control Center.

Please note that in VMware vRealize Appliance, vRealize Orchestrator is not enabled by default. To
enable this, log on to the VMware vRealize Appliance on Console as root and run the command:

service vco-configurator start
To make sure service is started when the appliance boots up, run the command:
chkconfig vco-configurator on

Note: This is a one-time step. This step is not required when using an external vRO server.

Log on the VRO appliance and verify that all services show a status of REGISTERED. Example URL to
https://<vRO-name>:5480

connect to your VRO appliance:
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fQQ VMware vRealize Appliance

Help | Logout user root

| System | Telemetry | Network | Update | Admin
Registered Services

M 4 1350f35 » » | Refresh| Unregister

A Service Service Type Last Updated Status

:g:vairc\:ed-designer- com.vmware.csp.core.designer.service 2017 Jan 3 11:49:48 REGISTERED
approval-service com.vmware.csp.core.cafe.approvals 2017 Jan 3 11:51:17 REGISTERED
authentication com.vmware.csp.cafe authentication 2017 Jan 3 11:48:45 REGISTERED
authorization com.vmware.csp.cafe authorization 2017 Jan 3 11:48:45 REGISTERED
branding-service com.vmware.csp.core.branding.service 2017 Jan 3 11:49:46 REGISTERED
catalog-service com.vmware.csp.core.cafe.catalog 2017 Jan 3 11:50:29 REGISTERED
component-registry com.vmware.csp.core.cafe.componentregistry 2017 Jan 3 11:48:03 REGISTERED
composition-service com.vmware.csp.component.cafe.composition 2017 Jan 3 11:51:25 REGISTERED
;gnwsigLe-proxy- com.vmware.csp.component.console.proxy.service 2017 Jan 3 11:49:45 REGISTERED
container-service com.vmware.csp.component.cafe.container 2017 Jan 3 11:52:02 REGISTERED
content-management com.vmware csp.core content service 2017 Jan 3 11:51:43 REGISTERED
gggg;:'r;tion-sewice com.vmware.csp.core.endpoint.configuration 2017 Jan 3 11:49:15 REGISTERED
event-broker-service com.vmware.csp.cafe event broker 2017 Jan 3 11:48: 11 REGISTERED
eventlog-service com.vmware csp.cafe eventlog 2017 Jan 3 11:48:12 REGISTERED
fabric-service com.vmware.csp.fabric.cafe fabric 2017 Jan 3 11:51:30 REGISTERED
forms-service com.vmware.csp.core.cafe forms 2017 Jan 3 11:50:38 REGISTERED
iaas-proxy-provider com.vmware.csp.component.iaas. proxy. provider 2017 Jan 3 11:51:27 REGISTERED
iaas-service com.vmware.csp.iaas. blueprint service 2017 Jan 3 12:20:01 REGISTERED
identity com.vmware.csp.core.cafe.identity 2017 Jan 3 11:48:44 REGISTERED
ipam-service com.vmware.csp.component.ipam.service 2017 Jan 3 11:50:53 REGISTERED
licensing-service com.vmware.csp.core.cafe licensing 2017 Jan 3 11:48:01 REGISTERED
management-service com.vmware. csp.component. management. service 2017 Jan 3 11:50:54 REGISTERED
network-service com.vmware.csp.component.network.service 2017 Jan 3 11:50:16 REGISTERED
notification-service com.vmware.csp.cafe notification 2017 Jan 3 11:48:25 REGISTERED
:;:\?i-cg:teway- com.vmware.csp.core.ol11n.gateway 2017 Jan 3 11:51:50 REGISTERED
placement-service com.vmware.csp.component.cafe placement 2017 Jan 3 11:50:28 REGISTERED
plugin-service com.vmware.csp.core._plugin.service 2017 Jan 3 11:48:01 REGISTERED
portal-service com.vmware.csp.core.portal service 2017 Jan 3 11:50:58 REGISTERED
properties-service com.vmware.csp.core.properties service 2017 Jan 3 11:49:16 REGISTERED
reservation-service com.vmware.vcac.core.cafe.reservation 2017 Jan 3 11:49:21 REGISTERED
shell-ui-app com.vmware.csp.core.cafe shell 2017 Jan 3 11:50:26 REGISTERED
software-service com.vmware.csp.component. software service 2017 Jan 3 11:50:01 REGISTERED
sts-service com.vmware. cis.core.sso 2016 Nov 29 15:23:25 REGISTERED
vCo com.vmware.vco.olln 2017 Jan 3 11:49:14 REGISTERED
workitem-service com.vmware.csp.core.cafe workitem 2017 Jan 3 11:48:25 REGISTERED

vmware

Copyright® 1998-2016 VMware, Inc. All rights reserved

Powered by VMware Studio
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4.3 Install Infoblox Plugin in VMware vRO

https://<vra-appliance-name>

1. Log on to the VMware vRealize Orchestrator Control center. Example:

vmware

VMware vRealize Automation Appliance

To access vRealize Automation:

= VRealize Automation console

To manage this appliance:

« Vhware vRealize Automation Appliance management

To install vRealize Automation components (laaS, Guest and Software Agents, Tools):

« vRealize Automation componentinstallation page

« Guestand software agents page

To connect to the built-in vRealize Orchestrator Server:

« vRealize Orchestrator Client

« vRealize Orchestrator Control Center (the service is stopped by default)

2. Click on vRealize Orchestrator Control Center and login with the username “root” and the
password used during setup.
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3. Click on the Manage Plug-ins button.

VYM Orchestrator Control Center =«
=
GO v 7 0 »* E & &
—m [}
Startup Configure  Host Settings Adwvanced Certificates  Orchestrator Validate Role Eased
Options Authentication Diptions Cluster Configuration ACcess
Provider Management Management
Monitor and Control
l &
i G =
Inspect Runtime Troubleshooting  System
War kflows Metrics Froperties
Database
x L 1
Purge Export Import
Database Databaze Database
Log
2 ® @
Export Logs Live Log Configure Logging
Stream Logs Integration
Plug-Ins l
Manage Plug-
Ins
rator plug-
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4. Click “BROWSE”.

Manage Plug-lns
Inztall 8 new plug-in or manage already installed plug-ing. The preferred plug-in installation file format is ¥MOAPP, but plug-ins can also be

installed as .DAR files.
When 'DEFAULT logaing level is selected for a specific plug-in the log level is inherited from the log level set in Configure Logs page.

Install plug-in
BROW SE

5. Traverse to the location of the plugin. The plugin file will use a .dar extension.
6. Select the plugin file and click “Open”.

&0

File Edit View Tools Help

. %« software » ib_vco_ipam_plugin_v_355544_d_355731_2017-05-25-05-11-49 » 430

Organize - | | Open Mew folder EEE 4
< Favorites Name Date modified Type Size

ﬁ] Infoblox_IPAM_vRO_Plug-In_4.3.0_UserGuide.pdf 5/25/2017 5:12 AM Adobe Acrobat D... 2959 KB
- Libraries | | ollnplugin-ipam.dar 5/25/2017 515 AM  DAR File 6,844 KB

7. Click “INSTALL".

VM Orchestrator Control Center ®

Manage Plug-lns
Install a new plug-in or manage already installed plug-ins. The preferred plug-in installation file format is ¥MOAPE, but plug-ins can also be

installed as .DAR files.
When 'DEFAULT logaing level is selected for a specific plug-in the log level is inherited from the log level set in Configure Logs page.

Install plug-in

¥ InfobloxI PAM 4.3.0.355544
Infoblox IPAM Pludgin

CAMCEL INSTALL

8. Click “SAVE CHANGES” to commit the plugin installation:

Changes are made but not saved.

CANCEL SAVE CHANGES
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9. Verify that the Infoblox Plugin now shows in the Plug-in list:

ntrol Center =

Manage Plug-Ins

ﬁ‘ Inztall 8 new plug-in or manage already installed plug-ins. The preferred plug-in installation file format is VMOAPP, but plug-ins can also be installed
as DAR files.

When 'DEFAULT' logging level is selected for a specific plug-in the log level is inherited from the log level set in Configure Logs page.

Install plug-in
ERCWSE

Flug-In Logging level Enable plug-in

M 4D z055377446

DEFALLT 4 ()
Arctive Directory X _—
b amar104.5244874
DEFALLT L4 ()
AMGP Plug-in & _
‘R Azure 1.0.05365515
DEFAULT & ()
Azure Plug-in & —_—
& configurator 7.3.0.54818 08
s DEFALLT = D
Configuration plug-in for vRealize Crehestrator & B —
4 DataManagemant 1.0.0. 2504108 Soloot. ., ()
Dxata Management plug-in for wCenter Crehestrator & -
¥l DynamicTypas 1.3.0.5416311
b b DEFAULT = D
Dynamic Types plug-in for vRealize Crehestrator & B —
B Enums 7014535818 o)
Select... ¥
Commaon enumerated types & e
& GEF 2.0042788M
DEFALLT w ()
wCAC Generic Endpoint Framewaork plug-in for vCenter Crehestrator & —
# InfobloxIPAM 4 3 0356544
DEFAULT & ()
Infoblox IPAM Plugin & —
' Library 7.01.4 935615
Select... e ‘)
Library plug-in for vRe alize Crehestratar & B —
B4 Mal 7014525618
DEFALLT 4 ()
Wail Plug-in & _
EB N5X 11.0.49688437 ()

CEFALLT @
MSX Plug-in for wCent er Crehestrator & e —
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4.4 |nstall NIOS Certificate

1. Click on “VM” button to go back to home screen.

ntrol Center 3

Manage Plug-lns

Install a new plug-in or manage already installed plug-ins. The preferred plug-in installation file format is ¥MOAPE, but plug-ins can also be
inztalled as DAR files.
When 'DEFAULT' logging level is selected for a specific plug-in the log level is inherited from the log level set in Configure Logs page.

Install plug-in

ERCWSE

Flug-In Logging lewvel Enable plug-in

M ap z055377446

DEFALLT w7 ()
Active Directory & —_—
b amaopi04524487
DEFALLT 2 D
AMGP Plug-in & _
‘B Azure 10.05366515
DEFALLT & ()
Azure Plug-in & —_—
& configurater 7.3.0.54 81808
s DEFALLT 2 t}
Configuration plug-in for vRealize Crehestrator & —_—
« Datakanagenment 1.0.0. 2504108 Seleot - D
Data Management plug-in for vCenter Crehestrator & [ —
Bl DynamicTypes 1.3.0.5416411
CEFAULT w7 ()
Dynamic Types plug-in for vRealize Crehestrator & e
B Enums 7014533616 o)
Select... 4
Commen enumerated typ es & —_—
& GEF 200427881
DEFALLT 2 D
vCAC Generic Endpoint Framewark plug-in for vCenter Crehestrator & S
& InfobloxIPAM 4 30355644
DEFALLT w7 (}
Infobloe IPAM Plugin & —_—
O Library 70414 5209616
Select.. b ()
Library plug-in for vRe alize Crehestrator & e
E4 mall 70140206818
DEFALLT & (}
Wail Plug-in & —_—
E! N5X11.0.4888437 (}

DEFAULT &
MEX Plug-in for wCenter Crehestrator & —_—
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2.

Click on “Certificates”.

vmM Orchestrator Control Center #

»JOQ/EIZ

Configure Advanced Certificates  Orchestrator Validate

Manage

Startup
Options

Monitor and Control

i

Inspect
Workflows

Database

X

Purge

Database

Log

(at

Export Logs

Plug-Ins

ri

Manage Plug-

Ins

Integration

Logging
Integration

Authentication Options Cluster Configuration

Provider Management

h n - —

& D) B =

Runtime JMX Console Troubleshooting File System System
Metrics Browser Properties

¥ 1

[ ~..] s
Export Import
Database Database

@ (@ [

Live Log Configure Logging

Stream Logs Integration
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3. Click on the “IMPORT” menu and select Import from URL.

VM Orchestrator Control Center =

Certificates

Manage the certificates used by the Orchestrator server.

Trusted Certificates Package Signing Certificate

Manage the Orchestrator trust store. Mark self-signed certificates as trusted by importing them to the internal trust store.

IMFCRT

Impert frem a PEM-encoded file
i Impert frem URL Delete

4. Type the URL for your NIOS appliance and then click IMPORT.

IMPORT FROM LIRL

URL nios.ga.com

Proxy URL : U=ze Proxy ()
CAMCEL IMPCRT

5. Click “IMPORT".

IMPCRT THIS CERTIFICATE?

Common Mame:nlos.gqa.com

Craanization:
Berial number: D0:00:0C0: 007144 :9f 4e:d3:d8: ch:e 80 b2:be: 28 e fh:D2:Ba

Signature algorithm: SHAZ2EBwithESA

Fingerprint [MDE]: f2:80:de 20408 46214501 06 Ofc8. 74 5.el

Fingerprint [SHA-1: 28:cf:22:68e . Je:dh:de:d3:blbfle: ef:e b:B1:f2: fe:7b:41:30:a8
Walid from: dun 7, 2017

“alid until: Mar 27, 2020

CAMCEL IMFCRT
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6. Verify that the NIOS certificate is now displayed in the Trusted SSL certificates list.

r Control Center =

Certificates

* Manage the certificates used by the Orchestrator server.

Trusted C ertificates Package Signing Certificate

Manage the Orchestrator trust store. Mark self-signed certificates as trusted by imparting them to the internal trust store.

IMFCORT ~

Trusted 550 certificate:

Common Mame: nlos.gacom T
Crganization:

Serigl number: OO:00c00: 00144 :Bfde:dB:dB:ch:e3:Bcb2:be: 2 B:eeifb:Be:Ba

Signature algorithm: SHAZ2EBwithRSA

Fingerprint [ME5): {2:30:de3b: 046348 3146811080 c8. 77 4520

Fingerprint [GHA-1): 28:cf.22:68e 7248 de:d3:b O:bfile: eFeb:61:f2:fe: 7b:41:2 5:a8

“alid from: Jun 7, 2047

“Walid until: Mar 27, 2020

Common MName: w2 2vm.gacom T
Crganization: IB

Serial number: QOO0 00 SO0 00 S0 00 OO oC:0 00 Be: b4 fB: 0 BB L Mied

Bignature algorithm: SHA25BwithREA

Fingerprint [MD5): 27.77.72:23d:5d:c3:6c:5e:b0 02:23:ec:06:86: 53593

Fingerprint [(SHA-1): B8:82:b7:af:B5:31:87:6a:d3:df:eD: 23:2e:ba:B5: 80 cd:d2:75: 28

Nalid from: Jun 1, 2047

Walid until: May 31, 2022

Common Mame: nsxm grga.co m T
Crganization: ¥iwara Inc,

Serial number: QOO0 Do D000 D0 D000 00 000000 00 O 00 0D 02:31: 5381

Signature algarithm: SHA2BBwithRSA

Fingerprint [MD5): 26:f:ed:b7T0ec 030006120188 81:58: 26 7b

Fingerprint [SHA-1): 4d:08:b4:d5:d&:44: 3F 747 e 6 fbb:d fflfe Bf.eB: 76 cH

“Walid from: May 31, 2017

Walid until: May 28, 2027

7. Click on the VM button to return to the Orchestrator Control Center home page.

© 2017 Infoblox Inc. All rights reserved. Infoblox IPAM Plug-in 4.3.0 for VMware VRA 7.3 Deployment Guide  June 2017 Page 18 of 147



8. Click on the Startup Options button.

VM Orchestrataor Control Center =

Manage
O %, 4 0 *® =E ~¢ ¥
—m [ )
Startup Configure  Host Settings Advanced Certificates  Orchestrator Validate Role Eased
Dptions Althentication D ptions Cluster Configuration Arccess
Provider Management Management

9. Click “RESTART” to restart the vRealize Orchestrator service. Note: this process may take couple
of minutes to complete.

VM Orchestrator Control Center =

Startup Options

Ll) Control the Orehestrator server service,

fi\, Server restar is reguired becauze ofnot applied configuration change.

Current Status: RUMMNING

START | STOF | | RESTART |

Status-ing tomcat instance Instance name: app-server Tomcat version: 8.5.14.@ Tomcat Base: svarflibjfwcosap
p-server Tomcat Home: fusrfshare/tomcat Status: RUNMING as PID=2@685

Version: 7.3.0

Build number: S481889

Build date: HMay 4, 2817

Database wersion: 1.88

Install path: fvarilibfvco

fctive Configuration Fingerprint: @37aefddlibifdci4ded4628F9bcadS52b7?
Pending Configuration Fingerprint: @324@faed68@F14552a69Fb59398d23c9
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10. Monitor the status while the restart is taking place.

Startup Options

Control the Orechestrator server service.

&, Server restart is reguired because of not applied configuration change.

Current Status:

Wersion: 7.3.@

Euild number: S4818@9

Build date: HMay 4, 2017

Database wersion: 1.88

Install path: Jfwarflibfweco

fictive Configuration Fingerprint: @37aefddl2b7fdc7dde9d62@F % cads2b?
Pernding Configuration Fingerprint: @324 @Facdf8@d+14552a69Fb59398d23c9

5. Setup Infoblox IPAM Endpoint Type

5.1 Accessing VMware vRealize Orchestration Server

The Infoblox IPAM endpoint is configured through the VMware vRealize Orchestration Server (vRO). To access
the VRO server:

1. Download the vRealize Orchestrator client from your vRA or vRO server.

Note: If using Embedded vRO, use the URL https://<vra-name>. For an External vRO, use the URL
https://<vro-name>.

VMware vRealize Automation Appliance

To access vRealize Automation:

+ vRealize Automation console

To manage this appliance:

+ “Muwvare vRealize Automation Appliance management

To install vRealize Automation compaonents (laa3, Guest and Saoftware Agents, Tools):

+ vRealize Automation component installation page

= Guest and software agents page

To connect to the built-in vRealize Qrchestrator Server:

s vRealize Crchestrator Client
s vRealize Orchestrator Control Center (the service iz stopped by default)
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2. Download and launch the Java Client. Continue through any warnings that may be displayed.

Security YWarning

Do you want to Continue?
The connection to this website is untrusted.

: ! 5 Website: https://vra73.qa.com:443

Mote: The certificate is not valid and cannot be used to verify the identity of this website,
More Information

[ Continuehj | Cancel |

3. Type your user name and password. Click Login.

VMuware vRealize Orchestrator Login...

Hostname (R 2 vRealize® Orchestrator

UETRIE TR administrator@vsphere.local

5.2 Run the Infoblox Setup Workflow

Now that the Infoblox Plugin has been installed, run “Setup Wizard” workflow to integrate the plugin
with VRO.

1. Inthe Run mode, toggle to the Workflows panel.
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2. Drill down into Library -> Infoblox -> vRA -> Installation.

vmware vRealize” Orchestrator-

Permissions

Inventory | Workflow Tokens — Events

¥ [ Library
» ] amap
» ] AMGP Samples
» T azure
> |=__| Configuration
» [ Data Management
» [ IData Management Samples
» ] Dyynamic Types
» CIHTTP-REST
b CIHTTP-REST Samples
¥ [ infoblo:
¥ []uRa,
> ] Adrminiztration
| Configuration
» Helpers
¥ [installstion
» CIPam registration
¥ [ vRO customization
» Setup Wizard
> Ed slocate
Create Endpoint Connection
» Create IP Ranges
Delete IP Ranges
> Get Address Spaces
b =4 Get IP Ranges
> Releaze
v E Update
il netwvork
Add range
Remowve DHZP record
Remove DMS record
Remove host record
Remove netvark
Remove range
Reszerve [P address
Reserve [P in network
Reszerve IP in range
Restart IPAM zervices
» [uoBC

Mame
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3. Right-click on Setup Wizard and select Start Workflow.

vmware vRealize” Orchestrator”

& B B3|

¥ o administrator & wraf 3.ga.com
¥ [ClLibrary
» Camap
+ [ &aMeP Samples
» [ azure
» [ Configuration
» [ Data htanacement
» [ Data hanagement Samples
» Dwnamic Types
» CHTTP-REST
» [IHTTP-REST Samplas
¥ [infoblosx
v CvRa
» [ Administration
> DConfiguraﬁon
» [ Helers
¥ [ installation
» CIPaM registration
» [IvRO customization
» = setup Wizard
> B sllocats
Creste Endpaint
> Creste IP Ranges
Delete IP Ranges

S Dok el o

B Start last workflow run

[ - s G

JGeneral‘lnputs OQutputs  Schema Presentation Parameters References  Workflow Tokens  Events  Permissio

MName Setup Wizard

D S4cc3des-c5e3-4017-8441- 27854129611
Wersion o|.|1]|.|0

Workflow icon

Owner Check signature...

Liser permissions Wiew contents Add to package Edit contents

Server restart behavior Resume worlkflow run

Resume from failed behavior  Sysiem default

Global tags

i Creates vRA and laas hostinstances invRO inventory,

Registers Infoblox IPAM endpoint type and install vRO customization in vRA.
Creates "Infoblox-Default’ property group with default settings in vRA dictionary.
If an error happens during execution of the workflow, all changes are rolled back.

4. For environments using external vRO or you are creating a new vRA host, set the Create VRA host
option to Yes and provide the information for vRA. Click Next and skip to step 6 in this guide.

o

¢ Start Workflow : Setup Wizard

1 vRA host

1a Hostproperti

1h User credentials
2 laaS host

2a Hostproperties

2b User credentials

2 Domain and Warkstation
3 Property group

3a Group properties

© 2017 Infoblox Inc. All rights reserved. Infoblox IPAM Plug-in 4.3.0 for VMware VvRA 7.3 Deployment Guide

Create vRA host

#* Host name

(®) Yes () No

R

Infoblox vRA Host

# Host URL

hitps:ivra®3.qa.com

Automatically install 351 certificates

() Yes (®) Mo

Connection timeowt

=

300

Operation timeout

60.0

Back Submit

Cancel Mext

June 2017 Page 23 of 147



5. Enter the User Credential information to be used for your vRA host and click Next.
a. Note: Skip ahead to step # 11 after completing this step.

- Start Workflow : Setup Wizard

1 vRA host

Session mode
v 1a Hostproperies

| Ehared Session

1h Usercredentials

2 laaS host
2a Host properties

# Tenart

2h Usercredentials vephere.local

2t Domain and Workstation
3 Property group

#* Authertication username

) R RS adrninistrator@vsphere local

# Authertication password

AEREXEEIRREL

| Cancel | | Back | | Mext | = Submit

6. For environments using embedded vRO and you will use the existing VRA host, set the create the
Create VRA host option to No.

7. Click on the magnifying glass (Not set) search bar.

- Start Workflow : Setup Wiizard

i
1 vRA host |
EB 1 error - [wRA host], Mandatory field not set

00

1h User credentials
2 laas host

Create vRA host

) Yes Ma
2a Hostpropeties - @
2h User credentials % vRA host
Zc Domain and Workstation % Mot set
3 Property group
3a Group properties | L
"¢ y, LU

Cancel Back I et Submit
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8. Dirill down to and click on the vRA server that you will be using. Click Select.

© Select {wCACCAFECACHDst ) ==

VCACHost - Default [https://ivra73.qa.com] [vsp...
J I_ﬂl' | J General | Custom properies
¥ {;ﬂ vRealize Automation

T Default [hitps 3.9a.com) [vsphere local]
kB TenantCafeHost[vsphere local][Adminiztrator][Per L

Last updated - 43 secands aga.

b B vaphere local[configursl Defauit hitns a7 2.ga.comi ivaphera docaiiwas updated - 45 seconds ago. _‘

Use Reload to retrieve a newer version.
AT Al Ty

sertags
Username administrator@vsphere.local
url hitps:ivra¥3.qa.com
| =3
| || | tenant vsphere.local JT
< J LS D IS
l Cancel J l Select J
9. Click Next.
© 0 Start Waorkflow : Setup Wizard @
i
1 vRA host |
Create vE& host
1a Hostproperies
L]
(%] 1b User credentials U Yes (@ No
2 laasS host % vRA host
23 Hostproperties % Default [https:ivra?3.qa.com] [vsphere.local]
2b Us=ser credentials
2c Domain and Workstation
3 Property group
Ja Group properties | v
- 'k,h V. Y| |
Cancel Back Mext Subrmit
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10. Enter the User credentials for your VRA host and click Next.

- Start Woorkflow : Setup Wizard @

1 vRA host

W 1a Host properties
1b User credentials administrator@vsphere.local

# Authentication username

2 laa5 host
Za Host properies
2h User credentials

#* Authentication password

EREXERELEL

2c Domain and Workstation

3 Property group

3a Group properties

| Cancel | | Back | | MNest | Submil

11. Provide your laaS host information and click Next.

+ Start Workflow : Setup Wizard @
1 vRA host Create laaS host

v 1a Hostproperties @ ves O No

v 1b User credentials
2 laasS host * Host name

2a Hostproperties Infohlox laas
2b User credentials
2c Domain and YWorkstation #* Host URL

3 Property group https: w201 2vm.ga.com
3a Group properties

Automatically install S5L certificates
(®) ves () Mo

Connection timeout

300

Operation timeout

60.0

Use proxy

() ves (®) Mo

| Cancel | | Back | | Mewt | Submit
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12.Provide your laas User credentials information and click Next.

o Start Workflow : Setup Miizard @
U el Host's authentication type
v 1a Host propetties -
v 1h User credentials (NTLM M
2 laa$ host #* Authentication user name
W Za Host properties

administrator

2h User credentials
2c Domain and Warkstation

3 Property group
3a Group propeties

* Authentication password

Rk EREEE IR

| Cancel | | Back | | Newt | = Submit

13.Provide your laas host Domain and Workstation information and click Next.

o Start Workflowe : Setup Mizard

1 vRA host
. Workstation for MTLM authentication
' 1a Hostpropedies
L 1h Usercredentials
2 |aa$ host
. # Domain for NTLM authertication
W 2a Hostpropetties
v 2h User credentials |qa.|:|:|m|

2c Dormain and YWoarkstation

3 Property group
3a Group properties

| cancel | | Back | | Nest | | Submit |
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14. Update the Group properties as required and click Submit.

© Start Wéorkflow : Setup Wizard

1 vRA host
W 1a Host properties
' 1h Usercredentials
2 |aaS host

L' 2a Host properties
v 2h User credentials
v 2c Dornain and Yvorkstation

3 Property group

15. The workflow will start executing and may take around a minute to complete.

& B 58|k

vmware vRealize® Orchestrator- G

#* Name

sl

Infablox-Default

Description

| Infollox: Default Propery Group|

“isihility

| All tenants

Mumber of virtual network interfaces

L1

Update existing property definitions

() ves (® Mo

Enakle support of Custom Hostnaming Extension for vEA

(® ves () MNo

Cancel . Back -

Submit |

¥ [Jinfoblox
v [vRa
» [ sdministration
» [ Configuration
» [Helpers
¥ [instaliation
b CIPAM ragistration
» VRO customization
v B3 sen

» K plocate
Creste Endpoint Cannection

v E Creste IP Ranges

» Ed Delete IP Ranges

» E3 Get sddress Spaces

» B Get IP Ranges

» B Release

b E Update

el network

#add range

Remowe DHCP record

Remowe DNS record

Remowe host record

Remowe netwark
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=] Setup Wizar
J Schema ‘ Events
[EA setup Wizard
O— ¢ —» —H
[
Initialize Create vRA host? ‘-”
i i -
| |
| I
| -7l
| |
v - v
i < -
_____ 2N ¢ —
2 - A — & — K — kA — 4
[« X |

General Variables ‘ Logs ‘
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16. Review the logs for the workflow to see the updates that were applied. This is also helpful to review
if any errors are encountered.

*General Wariables | Logs |

l ray. B . *“ﬂfﬂ v

Meszages
[2017-01-03 14:38:23.331] [1] Property definition “Infoblox. IPAKM. Network2. enableDhcp’ was not found.
[2017-01-03 14:38:23.350] [I] New property definition “Infoblox. IPAM. Network2.enableDhop' was created successfully!
[2017-01-03 14:38:23.457] [I] Property definition Infoblox. IPAKM. Network2. enablelns' was not found.
[201T7-01-03 14:38:23.476] [I] New property definition "Infoblox. IPAM.NetworkZ.enableDns’ was created successfully!
[204T7-01-03 14:38:23.591] [] Property definition ‘Infeblox. IPAM. NetworkZ2 meDhcpServer was not found.
[2017-01-03 14:38:23.611] [I] New property definition "Infoblox. IPAM. Network2 msDhepServer was created successfully?!
[2017-01-03 14:38:23.736] [I] Property definition ‘Infoblox IPAM. Netwaork3.dnsWiew' was not found.
[2017-01-03 14:38:23.752] [I] New property definition “Infoblox. IPAM. Network3.dnsView” was created successfully!
[2017-01-03 14:38:23.832] [I] Property definition “Infeblex. IPAM. Network3. aliases’ was not found.
[2017-01-03 14:38:23.847] [I] New property definitien "Infoblox. IPAM. Networkd.aliazes’ was created successfulky?
[2017-01-03 14:38:23.917] [1] Property definition “Infoblox. IPAM. Networkd. comment’ was not found.
[201T7-01-03 14:38:23,933] [I] New property definition "Infoblox. IPAM.Network3.comment’ was created successfulhy!
[201T7-01-03 14:38:24,003] [I] Property definition ‘Infoblox.IPAM. Network3.enableDhep' was not found.
[2017-01-03 14:38:24.026] [I] New property definition "Infoblox. IPAM.Network3.enableDhep’ was created successfully!
[2017-01-03 14:38:24.149] [I] Property definition 'Infeblox. IPAM Network3.enableDns' was not found.
[2017-01-03 14:38:24.168] [I] New property definition “Infoblox IPAM Network3.enableDng’ was created succesafully?
[2017-01-03 14:38:24.287] [I] Property definition “Infeblex. IPAM. Network3. msDhopServer' was not found.
[204T7-01-03 14:38:24.315] [I] New property definition "Infoblox. IPAM. Network3.msDhepServer was created successfully!
[204T7-01-03 14:38:24.416] [I] Property definition 'Infeblox IPAM . CustemHostname. ConditionalMachineCustomPropertyl.Name’ was not found.
[2017-01-03 14:38:24.437] [I] New property definition “Infoblox. IPAM.CustomHestname. ConditicnalMachineCustemPreperty).Name' was created successfully?
[201T7-01-03 14:38:24.557] [I] Property definition ‘Infeblox IPAM . CustemHostname. ConditionalMachineCustomProperty0.Value' was not found.
[2017-01-03 14:38:24.573] [I] New property definition “Infoblox. IPAM.CustomHestname. ConditionalMachineCustomProperty0.Value' was created successfuly?
[2017-01-03 14:38:24.688] [I] Property definition “Infoblex. IPAM. CustemHostname. ConditicnalMachineCustemProperty1.Mame® was not found.
[2017-01-03 14:38:24.706] [I] Mew property definition "Infoblox. IPAM.CustomHestname. ConditionalMachineCustomProperty1.Name' was created successfully?
[201T7-01-03 14:38:24,802] [I] Property definition ‘Infeblox.IPAM.CustemHestname. ConditionalMachineCustomProperty1.Walue' was not found.

FAARAT Ad AR 4SS AT P R TR DR ST SR T T R | TR T . SR SR (RPN SRR, S 1 S | DU N S SR AT S I 1 DU TR NPT T PP T

6.1 Create Production Tenant

Tenants are used to provide multiple environments within VMware. To complete the steps in this guide, an
existing tenant can be used if one (or more) already exist. To create a new tenant:

1. Login to vRA using your administrator credentials. Example URL: [ https://vra73.qa.com/vcac ]

https:ffvral3.qa.com/S8A5ASPHERE LOCAL faut c

NN
2N

Workspac

Forgat Password?
Change to a different domain

vmware

© 2017 Infoblox Inc. All rights reserved. Infoblox IPAM Plug-in 4.3.0 for VMware VRA 7.3 Deployment Guide  June 2017 Page 29 of 147



2.

In the Tenants panel, click + New.

Administration

Tenants Tenants
[ vew | & Ecit | x Delete
Branding Maime LIRL Mame Descrigtion

| Mew Tenant |

Enter the General parameters for the tenant and click Submit and Next.

— New Tenant
General

Branding

*Mame: | prod
Email Servers

Description: | Production Tenant

Event Logs
vRO Configuration > *URL name: |pr0d

Contact email: |pr0dadmin@vsphere.local

= Back Submit and MNesxt Finish Cancel

Click + New to create a new local user account.

Administration

B— New Tenant
Local users
Branding
Local Users
Email Servers Manage local users in tenant

| b Mew| # Edt 3¢ Dekte
Event Logs . =

| Mew [ocal user

Mo dlata to dEpmeEy—————
wRO Configuration »

= Back Mext = Finish Cancel
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5. Enter the User Details and click OK.

User Details:
" First name: Prod
" Last name: Admin
* Email: prodadmin@vsphere local

*User name: prodadmin
*Password: | seseesseses

* Confirm password; | seessseees q

OK Cancel
6. Click Next.

Tenants New Tenant
Local users
Branding
Local Users

Email Senvars Manage local users in tenant

& Mew # Edit X Delete
EventLogs [Marme Etmail

EJ prod admin (prodadmin@wvsphere.local) prodadmind@ey sphere local
vRO Configuration >

<Back | | MNest> | Finish Cancel
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7. Give tenant and laaS administrator permissions to the tenant administrator. In the search boxes,
type the administrators name, click on the search button and click on the search result to add the
administrator. Click on the Finish button once done.

Tenants New Tenant
Administrators

Branding

Tenant administrators laaS administrators I
Ermail Servers Select users or groups ta grant the Tenant Select users ar groups to grant the (aa3

adrministrator role. administratar role. =

Search Q pradadmin| Q)
Event Logs ) .

Maime (1] prod admin (prodadmin@vsphere.local) %
¥RO Configuration o ﬁ prod acdmin (prodsdming ... Mo csta selected -
= Back Mext = Finish Cancel

6.2 Create dev tenant

Follow the steps outlined in section 4.1 to create a tenant named dev. Create a user named devadmin
in this tenant.

6.3 Create ga tenant

Follow steps outlined in section 4.1 to create a tenant named ga. Create a user named gaadmin in this
tenant.

Tenants
4k New 7 x
MName URL Mame Description
vaphere.local vsphere.loc al
prod prod Produc tion tenant
dev dev Development Tenant
qa ga QA tenant
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7. Tenant Configuration

7.1 Before the tenant can be used, additional configuration must be completed.

Log in to the production tenant. Example: [ https://vra73.ga.com/vcac/org/prod J

https:/fvraTga com/SA854/PROD fauth /o c

A
@N

Workspace ONE
prodadmin

vsphere local

Forgot Fassword?

Change to a different domain

vmware

8. Navigate to Administration -> Users & Groups -> Directory Users & Groups.
9. Type the admin name (prodadmin) in the search box and click on the search button.
10. Click on the hyperlink for the admin account.

vmware vRealize® Automation Welcome, prodadmin. | Preferences | Help | Logout

Haome Inbox Design Administration Infrastructure

Directory Users & Groups prodadmin! ﬁt‘)

< Administration
You can view the Directory users and groups infarmation.

Directory Users and Groups D “iewy Details
Maime Description Ermail
Custorn Groups a Prod Admin (prodadmini@vsphere.docal)  Prod Admin prodadmini@ysphere local

Business Groups
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11. Enable the check boxes for the roles to be allowed in the Add roles to this User panel. If in doubt,
enable all roles and restrict these as needed at a later time. Example:

Add roles to this User.
# Application Architect
¥ Approval Administrator
« Catalog Administrator
# Container Administrator
#| Container Architect v

Authorities Granted by Selected Roles.
Access Ul
Access my tenant administration GUI.
Access my tenant directories, groups and users administration GUIs
Access the blueprint and blueprint component design GUI
Admin Requires System Admin
Administer the Metrics Provider configurations
Administer the Xaa$S configurations
Assemble, edit and publish composite blueprints for the tenant
Assign the tenant administrator role to other users
Configure blueprint service settings.

Configure software service settings.

12. Log out and log back in. This is required to reset your login session and make new configuration
items available.

13. Navigate to Infrastructure -> Endpoints -> Fabric Groups.

14. Click New.

Home Inbox Desigh Administration Infrastructure Caontainers

Fabric Groups
Flace compute resources in fabric groups and assign fabric administrators to manage thern.

< Infrastructure

Agents | o hlew
Mame < Fabric Administrators Description Compute Resources

Fabric Groups

Endpoints

© 2017 Infoblox Inc. All rights reserved. Infoblox IPAM Plug-in 4.3.0 for VMware VRA 7.3 Deployment Guide  June 2017 Page 34 of 147



15. Set the parameters for the fabric group and click OK.

Home Inbox Design Adrinistration Infrastructure Caontainers

New Fabric Group

Create 3 faliric group by assigning fabric administrators and selectthe compute resources that they can manage.

< Infrastructure

Apents *Mame: prad-fabric-graup

Description:  Production Fabric Grou
Fabric Groups ot P

Endpoints
Fabric administrators: Q
prodadming@wephera.local

Compute resources: Mame Encipoint Flatform Type
j_| Compute vCenter wSphere (vCenter)
j_| Momt vCenter wphere (wCenter)

| OKU| Cancel

16. Log out and log back in again. This is required to reset your login session and make new
configuration items available.

7.2 Create Production Business Group

Business groups are used to associate services and resources to a group of users. This enables the
users to be able to provision a VM. To create a business group:

1. Navigate to Administration -> Users & Groups -> Business Groups. Click + New.

Home ( X e Inkc Acdministration Infrastructure Cortainers

Business Groups

¢ &dministration
Business groups are required to creste ertitlements and uzers must be members of the business group to request entitled catalog tems.
Directary Users and Groups Advanced Search ¥
e New, o ] x E
cLsteniecles Hame ey Group Managers Ceseription Wirtual Machines ... Quota Allocated (.. Memorne Allocate...  Storage Allocate. .

Busginess Groups
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2. Enter the required values under the General tab and click Next.

Mewi Business Group

¢ Adminiztration
General
Directory Users and Groups
-
* Hame: | prod-business-group
Custom Groups ————
Description: |Production Business Group

Business Groups

*Send manager emails to: |pr0dadmin@vsphere.local i ]

Active Directory Policy |N0 policy selected v O

Custom properties:
d New 0 Edit ® Delete

Mame Walue Encrypted Show in Request

=Back | Mext= . | Finish Cancel

ey

3. Search for your tenant administrator account and assign it to all available roles. Click Next.

tructure

< Adrninistration New Business Group

Members
Directory Users and Groups
Group manager role: | = exrch Vi ] B
Custormn Groups
Mame (1)
Business Groups ;.“j Prod Admin (prodadmin@vsphere.local)
Support role: |Search X0
Mame (1)
EJ Prod Admin (prodadmin@vsphere.local) =
Shared access rale: |Search X0
Mame (1)
5 Prod Admin (prodadmini@vsphere.local)
User role: || {\,‘ (i )
Mame (1)

EJ Prod Admin (prodadmin@vsphere.local)

<Back | | Mest= | Finsh cancel
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4. Select the Default machine prefix and click Finish.

Home Inbox Desian Administration Infrastructure Con

< Adrministration New Business Group

Infrastructure
Directory Users and Groups
Default machine prefix: ‘ prod- v O
Custom Groups N _ N
Active Directory container: ‘ (i )

Business Groups

< Back Mest= | Finish | | Cancel

—

5. Verify that the Business group now appears in the Business Groups list:

Home Inbox Design Administration Infrastructure Containers

« Administration Business Groups

Business groups are required to create entittements and users must be members of the business group to request entitied cat

Directory Users and Groups Advanced Search
4 New & ) X =]

Custom Groups MName Group Managers Dresc ription
prod-business-group predadmin@vsphere.loc al Production Business group

Business Groups

7.3 Create Reservation

Reservations are used to assign resources that will be available to a business group when provisioning
services. In this example, we will create a vSphere (vCenter) reservation:

1. Navigate to Infrastructure -> Reservations -> Reservations.
2. Click + New and select vSphere (vCenter).

Infrastructure

Reservations

< Infrastructure

Review information aboutthe listed reservations. Machine count and memory usage include only machines that are powered on.

Key Pairs Advanced Search ¥
o Mew v | x
Reservations Amazon EC2 Machines | Guota Memary Storage
Businesz 2 Re=zervation achines Allocated Allocated Allocated Allocated
Azure Type U Groug Pri— | poliey Tatal (%) (%) (%) (%)
Reservation Policies (AllocTatal)  (SlocRes)  (AlocRes)  (AllocRes)

Hyper-4 (SCYRM)

Hyper-+ (Standalone)
MNetwork Profiles

Kb (RHEW)

. Crpenstack

Flacement Policy

wCloud Air

wCloud Directar

| wSphere (vCenter) ﬂ

HenServer
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3. Set the parameters under the General tab and switch to the Resources tab.

Home Inbox Design Administration Infrastructure

T New Reservation - vSphere (vCenter)

Create a reservation to allocate provisioning resources to a business group in a te

Key Pairs General Resources  Network @ Properties — Alerts
*Name: |prod—reser\.fatiun
Reservations
* Tenant: |prod v
Reservation Policies * Business group: |pr0d—bu5iness~gmup -
Network Profiles HESEnVELion poRcy: | M
* Priority: | 1 3|

Enable this reservation

4. Assign the resources for the reservation and switch to the Network tab.

New Reservation - vSphere (vCenter)
Create a reservation to allocate provisioning resources to a business group in a tenant. You also can copy an existing reservation to use as a starting point.
General Resources Network Froperties Alerts
* Compute resource: |00mpute (vCenter) hd
Machine quota: | Unlimited % | @
*Memory (GB): Physical Total Reserved Total Alloc ated This Reservation
10 0 0 3d
* Storage (GB): Storage Path Physical Free Total Reserved This Reservation Reserved
& @ datastore (1) 92 88 0 30
Resource pool: w
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5. Assign the Network Adapter and Network Profile to be used.

NEw Reservation - vSphere (vCenter)
Create a reservation to allocate provisioning resources to a business group in a tenant. You also can copy an existing reservation to use as a starting point.

General  Resources  Network  Properties  Alerts

Network: Metwork Adapter Metwork Profile

dvPortGroup

|

dvSwitc h-DVUplinks-42

WM Metwork

=

vxw-dvs-4d-virtualwire-11-sid-5000-Web- Switc h

veow-dvs-42-virtuahwire-2-sid-5001-Transient-Switch

oo

] wew-vmknic Pg-dvs-43-0-03dbfd73-14ac-4¢ d0-8850-60e18f4c flca

6. NSX settings are configured in the Advanced Settings section found below. In this example, we are
using the following:

Advanced Settings

Transport zone: |Global-Transport-Zone v

Security groups: [] Activity Monitoring Data Collection

Distributed logical Name Network Profile
router:
Logic al-Router-01 Infablox-External
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7. Click OK to save the reservation.

Home

New Reservation - vSphere (vCenten)

Create @ reservation to allocate provisioning resources to a business group in a tenant. You also can copy an existing reservation to use as a starting point

< Infrastructure

key Pairs

Copy from existing reservation: | A
RESENation General ~ Resources Neiwork Properties  Alers
-

Reservation Policles Metwork: Metwork Adapter IMetwork Profile

[[] DSwitch-DWUplinks-17
Metwark Profiles [[] ExternslPartGroup =

M Metweork: Infobloy-External-172 261.0/24  ~
Placernent Palicy

[ wwe-dlez-1 T-virtualwire-1 -sid-S000-web-dbswitch

|:| Wi -YINkNICPY-dve-17-0-he321ha7-53165-4952-ated-6402ba31 0309

Advanced Settings

Transport zone: |glnha|-transpur1—znne N

Security groups: | []  &ctivity Monitoring Data Callection

Cancel

‘O
>~

8. The reservation will now be displayed in the Reservations list:

Home Inbox Design Administration Infrastructure Containers

¢ Infrastructure Reservations

Review information about the listed reservations. Machine count and memory usage include only machines that are powered on.
Advanced Search

Key Pairs

4 New~ 7 X
Reservations

Name « Type Tenant Business Group Priority
Reservation Policies ﬁ prod-reservation vSphere (vCenter) prod prod-business-group 1

Network Profiles

7.4 Create Production Service

To configure the production service:

1. Navigate to Administration -> Catalog Management -> Services.
2. Click + New.

Home " N Administration

< Administration Services Search

Create, edit, publish, and manage serices.

Services | 4 Mew

D Wigne Ditails ,:1 Copry M Delete u Activate E: Manage Catalog fems

Mame = st | Status Description Last Updated On Last Updatedd By

Catalog tems

Mo data to display

Actions

Entitlements
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3. Set the parameters for the service and click OK.

iR Adrninistration
< Administration New Service
_ . .
Senices Hame: |pmd—sewice

Description: | pyoqyction Service
Catalog ltems

Actions

lcon: | Browse.
Entitlernents Preview:

Status: | acjive v

Hours: | w UTC-07:00  to | ~ UTC-07:00 @

Owner: |F'r0dAdmm(pmdadmin@vsphere.\ocal) x O

Support Team: |Pmd Admin (prodadeingrsphere localy x O
Change Window: | . | ~ UTC-07:00 to ‘ W UTC-0T:00 €

| QK | Cancel

Y

4. Verify that the Production Service is now shown in the Services list:

Services

Create, edit, publish, and manage services.

4k New |5 | x 4 -
Name a Status Diescription
prod-service Active Produc tion Service

7.5 Create Entitlement

Create a new Entitlement

1. Navigate to Administration -> Catalog Management -> Entitlements.
2. Click + New.

Home

¢ Adminiztration Entitlements

Create and manage access to your catalog tems in the service catalog, and the actions you can run on
) provizioned tems. When you ertitle services, catalog tems, and actions, you grant sccess to one or
Services more members of & selected buziness group. You can also apply approval policies to the services, tems,
and actions, and then prioritize multiple entitlements for the same business group to set the order in
wehich approvals are applied.

Catalog tems =
& New| # Edit X Delete 0O ceactivate rn Eriaritiza
. Mame Order Descripti... Status Expires ... LastUpd... Last Upd...
Actions | Mevwy Entitlement | & G & &
Entitlements
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3. Set the parameters for the entitlement, making sure to set the Status menu to Active. Click Next.

Home Inbax Design Adrninistration Infrastructure Caontainers

New Entitlement

< Administration

General
Serices

*Users & Groups: i )

Catalog ltems " Name: |pr0d-entit|ement ‘

AllUsers and Groups
Description: |Production Entitlernent

Actions Sl ~
Ilame
Entitlements
Expiration Date: (i) v
*Status: | Active v 0
* Business Group:
= Back | Mest = | Finish Cancel

4. Click the + symbol for Entitled Services and select the service to be used. Click OK.

New Entitlement
Add Services

tems & Approvals
Name: Search

Selectthe senvices, items, and
the zervice catalog. Actions are A Mame
services, items, and actions wit
prod-service
Entitled Services ¢
Search
Mame Approval

Mo data selecte

Apply this policy to selected items: | (hone) v

| Ok L\\ | Cancel
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5. Click on the + symbol for Entitled Actions.

New Entitlement

tems & Approvals

Selectthe services, items, and actions to include in this entitterment. With the exception of actions and blueprint components, entitled iterns appearin
the service catalog. Actions are available only after items are provisioned. To apply different levels of governance, you can configure individual
senvices, items, and actions with different approval policies. ¥ou can change the approval policies associated with entitled iterms at any time.

Entitled Services =p @ Entitled tems < @ Entitled Actions <k i )
Search Search [¥] Actions only appdo efined in this
entitlement _Add Actions
Mame Approval Policy Mame Approval Policy
Search
prod-service ‘none’) - Mo data selected
Mame Approval Policy

6. Enable the appropriate Entitled Actions and click OK.

MNew Entitlement

e dd Actions
. Type: | Al hd
Selectthe service
semvice catalog. £ Mame: | Search
iterns, and actior
Entitled Service k - Mame Type
Search
Associate Flosting IP Machine
Iame
Cancel Reconfigure Machine
prod-service
Change Lease Deployment
Change Lesse Maching
Change MAT Rules Metwork
Change Cryner Deployment
Change Security Deployment
Connect to Remote Console Machine
{511 Cannect Hsine Consnle Tickst Warhins

Apply this policy to selected items: | inane)

0Ok

= Back MNext =

Click Finish.
8. The Entitlement will now show in the list:

~

Entitlements

fmcoriste Flos reme -

'ms appear in the

al senices,
= L]
|E| #fined in this
‘olicy
v
Cancel
Finizh Cancel

Create and manage access to your catalog items in the service catalog, and the actions you can run on provisioned items. When you entitle services, catalog
the services, items, and actions, and then prioritize multiple entitiements for the same business group to set the order in which approvals are applied.

4k New & 4 j Ty
MName Business Group = Order Drescription Status
prod-entitlement prod-business-group 1 Produc tion Enfitlement Active
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8. Create Endpoints in vVRA

8.1 Create Infoblox NIOS Endpoint

Create the Infoblox NIOS Endpoint in vVRA

1. Connect to your VRA appliance and launch the vRealize Automation console.

&« > C |A Mot secure | L#HEE:/vra73.ga.com

Q #|

VMware vRealize Automation Appliance

To access vRealize Automation:

» vRealire Automation console

To manage this appliance:

= Whivware vRealize Automation Sppliance management

Toinstall vRealize Automation components (laa3, Guest and Saoftware Agents, Toals):

s vwRealize Automation component installation page

« Guest and software agents page

Tao connect to the built-in vRealize Orchestratar Server:
» vRealize Orchestrator Client
« vRealize Orchestrator Contral Center (the service is stopped by default)

To see vRealize Automation AP documentation:

» vRealize Automation AP documentation

https:ffvraf3qa.comfvcacy Whiware, Inc. All rights resenved.

“hiware v Realize Automation Appliance wersion 7.

2. Log in using the account that has been created in VRA. In the example here, we have created

the account “vraadmin” in the domain vsphere.local.
3. Navigate to Infrastructure -> Endpoints.
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4. Drill down through the + New menu and select IPAM -> Infoblox.

vmware vRealize® Automation . devadmin. | Pr Help | Logout

Home log ftems R In Administration Infrastructure

Endpoints

¢ Infrastructure
Wanage endpoints that represent infrastructure sources or external systems.

Agents g N -| # x ] .

Claud I wpe Auddress User Name [rescription
Fabric Groups | 1P b 3 Il [ - ||.co... administrator@...
Management b |||Lpb.ff@||gr.qa... administratonih...

Center)  hitpsiffvesa.ga.co...  administraton@e...

Endpoints Hetwork and Security
rches...  hitpsiffvra?3.qa....  administraton@ne...

b
Orchestration I
Storage [
Wirtual k
[izplaying 1 - 4 of 4

Fage |4

Copyright re, Inc. Al rights rese wersion 7.5.0 (build 549:3915) Privacy Policy Contact us

5. Provide the connection details for the connection to your Infoblox appliance. Click OK.

Note: It is recommended to use a Cloud APl account in NIOS. This enables the Infoblox IPAM plugin to send cloud specific data in its updates.

Home [ E e Addministration Infrastructure
Meww Endpoint - Infoblox
¢ Infrastructure P
Create an endpoint.
Agents General Properties
N Fe
Hame: |infohiox NIOS
Fabric Groups
Description: |Infoblox MICOE Endpairt
Endpoints
Address: |Hl1ps:.l'rnins.qa.ccum
User name: | cloudsdmin
Password: |ssssssss
w
4 3
[0034 Cancel
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6. The Infoblox NIOS endpoint for IPAM will now show in the endpoint list:

Harme: Catalogy ftems Reguests Ik Design Administration Infrastructure Cortainers

Endpoints

¢ Infrastructure
MWanage endpoints thet represent infrastructure sources or external systems.

Aoerts g N.+ #E. | X Dele.. | {8 Actio.. =
Mame = Flatform Type Address Usar Mame Crescription
Fabric Groups Infobloe Infoblos https:#fnios.qa.... cloudadmin
whRO vRealize Orche... https/fwraTZ.qa... administraton@...
- wilenter vSphere (vCen... htpsifvcsa.gqa....  administraton@...
Endpoint=

8.2 Create NSX endpoint

When employing Network Virtualization using VMware NSX (Network Virtualization and Security
Platform), you will also require an endpoint for your NSX server. To create this endpoint:

1. Navigate to Infrastructure -> Endpoints -> Endpoints while logged into your tenant for vRA
Note: In this example, we use a tenant named ‘deV’: https://vra73.ga.com/shell-ui-app/org/dev).
2. Click + New, drill down into Network and Security and select NSX.

vmware vRealize Automation

Home Catalog lterms Reguests Irbros Design Administration Infrastructure

Endpoints

¢ Infrastructure
Manage endpoints that represent infrastructure sources ar exter

Agents db Mew = | » b -

Cloud 3 Platform Type
Fahric Groups [P bl " vRealize Orohestrator
Management b vEphere (vCerter)
Endpoints Metweork and Security B “ RISH o
Crchestration fr Prosy
Storage 3
Mirtual 3

© 2017 Infoblox Inc. All rights reserved. Infoblox IPAM Plug-in 4.3.0 for VMware VRA 7.3 Deployment Guide  June 2017 Page 46 of 147


https://vra73.qa.com/shell-ui-app/org/dev

3. Enter a descriptive name for your NSX endpoint, along with the address, user name and
password used for the connection to your NSX server.

Horme G G EMS =T = ) L ian Infrastructure Contai

New Endpoint - NSX

Create an endpoint.

¢ Infrastructure

Agents Froperies Associations
*Name: |
Fahric Groups
Description:

Endpoints

“Address: | pipsinssmgroa.com

“User name: | sdministrator@vsphere.local

*Password: | ssssssss

Test Connection Ok Cancel

Click on the Associations tab.

Click + New.

Click on the dropdown menu under the Name column and select the menu item for the vCenter server
that you want to associate with your NSX endpoint.

7. Click on the Ok button located just below the row for the association that you are adding.

S

lterms Reguests e sign Administration Infrastructure Containers

New Endpoint - NSX

Create an endpoint.

< Infrastructure

Agents General  Properties  Associations

Configure associations with other endpaints.

Fabric Groups
& Edt | 3 Delete

Endpoints W= Platfarm Type Description
vCerter w | vEphere (vCenter) wSphere to MNSX Associstion
Ok Cancel
Test Connection (o] Cancel

8. Click on the Test Connection found at the bottom right of the window. Accept any prompts or Security
Alerts that may be displayed, allowing you to confirm that the connection between your vCenter server
and NSX endpoint is working.
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9. Very that the connection test completed successfully.

Success
The test connection was successful.

Infrastructure

New Endpoint - NSX

Create an endpoint.

¢ Infrastructure

Agents General  Properties  Associations

Configure associations with other endpoints.
Fabric Groups
op Mew o Edit | 3¢ Delete

. Mame Platfarm Type Deszcription
Endpoints o g
wiZenter wEphere (vCenter)  vSphere to NSX Associstion

Test Connectio

Ok Cancel

10. Click OK.

Hame 5] = d Infrastructure

Endpoints

¢ Imfrastructure
Manage endpoints that represent infrastructure sources or external systems.

Bgents & N.+r #E. | %Dzl | @actio.. -
Hame = FPlatform Type Addressz Usar Hame Dezcription
Fabric Groups Infobl o Infoblox https:¥nies.qa....  cloudadmin
HEH ME5X https:&fns=<mgr....  administrator...
" w Certer \tSpherl_%Cen... https:fhieza.qa....  administraton@...
Endpoints
wRO vwRealize Orche... hitpsiiiera?3 ga...  administratorn@...
Fage |1 of 1 g @ Dizplaying 1 - 4 of 4

8.3 Create External Profile

Create the External network profile which will be used to set the network parameters for a machine
blueprint.

1. Under Infrastructure -> Reservations -> Network Profiles, expand the + New menu and select
External.

Home Catalog tems Requests Inbox Design Administration Infrastructure Containers

Network Profiles

MNetwork profiles specify network settings in reservations and blueprints. Network profiles are used to configure network interfaces when
“Ms are provisioned, and to specify the configuration of NSX Edge devices that need to be created when provisioning multi-machines.

¢ Infrastructure

Key Pairs
4 New - | ] *®

Reservations |E| Tvpe Description
B nar

Reservation Policies Q Routed

Network Profiles
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2. Set the parameters for the profile and select the Infoblox NIOS endpoint for IPAM:

Inkbioz:

Mew MNetwork Profile - External

¢ Infrastructure
Create & network profile to manage one or more named ranges of static Pv4 network addresses
Wey Pairs General Metwiork Ranges
L\} * Hame: |Infoblox-E)darnal-Profile
Reservations

Description: |Infoblax External Profile

Reservation Policies

Hetwork Profiles IPAM endpoint: |Infobl0x ~@

Placement Policy

Ok Anpby Cancel

3. Switch to the Network Ranges tab.
4. Click on the Address space menu and select the Network View in NIOS that you want to use for
this profile.

Note: If no network view is selected, the “default” network view is used automatically.

Home Catalog 7 Inkac: Deszign Administration Infrastructure Containers

e Metwork Profile - External

¢ Infrastructurs
Create a network profile to manage one or more named ranges of static IPvd netwark addresses.
Key Pairs General | Hetwork Ranges
-
Address space: |any ~ D
Reservations HName = Dresoription
A R
G e default
q . Stat IF « —

Reservation Policies Fage |4 of 1 @ Displaying 1- 1 of 1

Ao e exist

Hetwork Profiles

Placement Policy

Ok Apply Cancel

5. Click on + Add button.

Irkac e Add i3 in Infrastructure

Mew Metwiork Profile - External

¢ Infrastructure
Create a network profile to manage one or more named ranges of static Pv4 network addresses.
Wey Pairs Genetal Hetwork Ranges
P
Address space:  default A |0
Reservations
|+ A » Remo..
Reservation Policies Start IF End IP Mame Deseription
Mo tems exist.

Hetwork Profiles

Placement Policy

QK Apply Cancel

6. Click on the Search button

Note: See the Appendix for information limiting search results
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7. Select the network or range in NIOS that you want to be used for IP provisioning. Click OK to
close the Network Range selector.

Home: Ca =] ftems Reque Inbio Design Addminis i Infrastructure Containers

Mew Metwork Profile - External

¢ Infrastructure %
Create aned Select Hetwork Range
Key Pairs Genersl | Search 40
|:| Start IP = End IF Mame Crescription
Reservations [¥] 172.26.1.1 172 26.1.254 172,26 1.0/24
o A [F]| 172.26.1.180 A72.26.1.199 AT226.1.180 - 172.26.1..

il i Start IF —_—
Reservation Policies " 04 ES S
Hetwork Profiles | [ e G e

b,

Placement Policy

8. Select the range to verify its DHCP options.

Note: The DNS suffix must be configured in the properties for the network and/or range in
NIOS. If this is not completed, provisioning done by the Infoblox IPAM plugin will fail.

Home Catalog e [ Design Administration Infrastructure

Mewi Metwaork Profile - External

Creste a network profile to manage one or mare named ranges of static IPyd network addresses.

¢ Infrastructure

Kevy Pairs General | Hetwork Ranges

Address space:  any
Reservations
g A ¢ Remo...

R T BalEEs Start IP = End IP Name Description
1722611 172.26.1.254 172.26.1.0/24
Hetwork Profiles
Placement Policy
Details for Selected Range ¥
a
Hame: 172.26.1.0024 Primary DHS: 10102310 Additional information:
Mame Walue
Description: Secondary DNS:
Start IP: 1722611 DHS suffix: oa.com
End IP: 172261254 DHS search suffixes:
Subnet mask: 24 Preferred WIHS:
Gateway: 1722611 Alternate WINS:
g
4 3

| Ok E | Apply Cancel
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9. Click OK to save the network profile.

Home Catalog ftems Re Infac: Dezign Acminiztration Infrastructure Cortainers

~ Mew Network Profile - External

¢ Infrastructure
Creste a network profile to manage one or more named ranges of static IPv4 network addresses.
Key Pairs General  Hetwork Ranges
-
Address space:  any
Reszervations
3 Remo...
Reservation Policies Start IP = End IF Mame Drescription
172.26.1.180 A72.26.1.199 AT226.1.120 - 172.26.1.189
Hetwork Profiles =
4 3
Placement Policy | folte | Apply Cancel

8.4 Add a Reservation

Add the configured External Profile to the reservation

Edit Reservation - vSphere (vCenter)
Change setlings in a listed reservation.

General Resources  Network  Properties  Alerts

Network: Metwork Adapter MNetwork Profie
dvPortGroup

dw Swite h-DVU plinks-43

oo

WM Metwork Infoblox-External v

=

vaw-dvs-43-virtuahlwire- 11-sid-5000-Web-Switc h
waw-gvs-4 3-virtuahwire-3-sid-5001-Transient-Switc h

wvaw=vmknic Pg-dvs-43-0-03dbfd73-14ac -4¢c d0-8850-60e18f4cfOca

OoO

9. Single Machine with External Network Profile

9.1 Single Machine Blueprint

Create a Single Machine blueprint. If using NSX, make sure to set the Transport zone.

Note: This is not required for non-NSX environments.
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New Blueprint

General NSX Seftings Properties

“MName: | Infoblox-Single-Web

*ID: ||nfob|nxSingIeWeb
Aszsign a permanent, unigue 1D to this blueprint.

Description:

* Archive (days):

Deployment limit:

Lease (days):

Infoblox Single Web VM|

=)
>
=

<
e

Minimum

Maximum

Y
e

4>

OK Cancel
Here we have name the machine as “Web” and selected machine prefix “prod-*
Dewn Canvas ® Q
¥ \Web x
) vSphere Machine
vSphere_Machine_1
General Build Information Machine Resources € Storage MNetwork Security Froperties
"ID: | Web
Description: |Web VM
[C] Display location on request (@
Reservation policy: | v @
Machine prefix: | prod- v @
Minimum Maximum
“Instances: | 1% 15 0
Save Finish Cancel
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Fill Build Information -

v Sphere_Machine_1

4+ (General Build Information Machine Resources Storage Network Security Properties

Blueprint type: | Server v 0
Action: |Clone v 0
" Provisioning workflow: | CloneWorkflow v 0

* Clone from: |Linux

Customization spec: |Linux

Select Network and Security and drop Existing Network on the canvas.

New Blueprint: Infoblox-Single-Web &
Categories Design Canvas @® Q
@B Machine Types
| Software Components
Blueprints
g MNetwork & Security | 8] e
g XaaS
48 Containers

& Other Components

-ﬁ ) vSphere Machine

Q Container Network
X
@ Existing Network @ Existing_Network_

Existing Security Group A

Existing Security Tag
ﬂ On-Demand Load Balancer Existing_MNetwork_1
B, On-Demand NAT Network General¢  DNSMWINS P Ranges
On-Dx d Routed Network
& Or-Demand Routed Networ * Network profile:
On-Demand Security Group
Description:

Save Finish Cancel
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Select “network Profile” and use Infoblox-External network profile.

Select Network Profile
Name

Infoblox-External

Page |1 of 1

Design Canvas

Existing_Network_1
General IP Ranges

* Network profile:  Infoblox-External

Description: | Infoblox External Profile

IPAM endpoint: Infoblox NIOS

Gateway:

Description

Infoblox External Profile

¥ Web

) vSphere Machine

I@ InfobloxExternal % |

Save
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Displaying 1-10of 1

Cancel

Cancel
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Select Web VM and add Network -

Design Canvas

¥ Web x

) v5phere Machine

@ InfobloxExternal

Web
General Build Information Machine Resources Storage Network Security Froperties
# Edit | X Delete
ID «  MNetwork Assignment Type Address Load Balancing
0 Infoblox External w || Static IP v
OK Cancel
Maximum network adapters: c (i ]

Save
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Design Canvas @ @

 Neb x

) vSphere Machine

@ InfobloxExternal .

Web

General Build Information Machine Resources Storage Network Security Properties

4 New o Edit | X Delete

ID « Network Assignment Ty pe Address Load Balancing Custom Properties
o Infoblox External Static: IP ra
Maximum network adapters: | nlimited c [i ]
Save Finish Cancel

9.2 Add Property Group to VM

Web

General Build Information Machine Resources Storage Network Security Properties

Property Groups Custom Properties

Description

Mo data to display

View Merged Properties |

Save Finish Cancel
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Add Property Groups »

] | Name « Description
D Container host properties with ¢ ertific ate authe... Sample property group with custom properties for container host using certific ate and private key ...
|:| Container host properties with user/ipassword ...  Sample property group with custom properties for container host using user and password credent...
Infoblox-Default Infoblox Default Property Group
[4 4 | Page |1 of 1 | | &2 Displaying 1 - 3of 3
OK Cancel

Infoblox Default Property

Web

General Build Information Machine Resources Storage Network Security Properties

Property Groups Custom Properties

= 3 x
Description

Infoblex- Default Infobilex Default Property Group

View Merged Properties | @

Save Finish Cancel

Blueprints

Create and manage blueprints. Publish a blueprint to allow architects to reuse your blueprint, and to allow catalog administrators to entitle users to request your blueprint from the
catalog.

% New 7 1 Qo O x

Mame Description Status Last Modified +
Infoblox-Single-Web Infoblex Single Web VM Draft 132017, 8:44:30 PM
Docker - PhotonO5S Sampile template for provisioning Docker ho...  Published 12017, 12:20:26 PM
Docker - Core05 Sample template for provisioning Docker ho...  Published V2017, 12:20:26 PM

9.3 Publish Blueprint

Blueprints must be published before they can be used. To publish a blueprint:

10. Select the row for your blueprint.
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11. Click on the Publish button.

Blueprints
Create and manage blueprints. Publish a blu: to allow architects to reuse your blueprint, and to allow catalog administrators to entitle users to request your blueprint from the
catalog.

+ Mew # Edit _ﬁj Copy 0 Publish M Delete

MName Description Status Last Modified +

Infoblox-Single-Web Infoblox Single Web VM Draft 132017, 8:44:30 PM

Docker - PhotonO 3 Sample template for provisicning Docker ho... Published 1732017, 12 5 PM

Docker - CoreO5S Sample template for provisicning Docker ho... Published 1732017, 12 PM

12.Verify that the status for the blueprint changes to Published.

Blueprints
Create and manage blueprints. Publish a blueprint to allow architects to reuse your blueprint, and to allow catalog administrators to entitle users to regquest your blueprint from the
catalog.

o New # Edit [[3Copy ) @ Unpubiish | X Delete

Name Description Status Last Modified «

Infoblox-Single-Web Infoblox Single Web VM Published 1IA2017, 8:44:30 PM

Docker - PhotonO 5 Sample template for provisioning Docker ho... Published 132017, 12:20:26 PM

Docker - CoreQ$ Sample template for provisioning Docker ho...  Published 1HN2017, 12:20:26 PM

9.4 Add Catalog item

To use catalog items, you must specify the Service they will use.

1. Inyour vRA tenant, navigate to Administration -> Catalog Management -> Catalog Items.

2. Click on the row for the Catalog Item that you want to configure (taking care not to click on the
hyperlink for the Catalog Item’s name).

3. Click Configure.

Inbo: Administration

Catalog ltems

¢ Adminiztration
Catalog tems are publizhed blueprints, Xaa3 blueprints, and software components. These biueprints and components are published on the Design tab or using the vRealize
. Automation AP, To make & catalog tem available in the service catalog, add the item to a zervice and then entitle the catalog tem to & business group. Software componerts can
Services alzo be enttled to enforce approval policies, but they can only be requested as part of a bluepeirt. If you unpublizh s catalog tem, twill no longer be available in the service
catalog.
Catalog ltems Advanced Search ¥
b Configure{tp Deadivate
Actions . .
Name = Configure Catalog tem Status Source Resource Type Scope Appears in Cataleg Senice [e...
Infoblas- Singla-tish Published Blueprint Senice Deployment Shared Yes Singh

© 2017 Infoblox Inc. All rights reserved. Infoblox IPAM Plug-in 4.3.0 for VMware VRA 7.3 Deployment Guide  June 2017 Page 58 of 147



4. Expand the Service dropdown menu and select the service to be used. Click OK.

Home Catalog i = Inka Desian Administration frastructure Cortainers

Zonfigure Catalog lem

¢ Adminiztration

General  Enttlements

Services
Hame: Infoblox-Single-vveb
Catalog Hems
Source: Blueprint Service
Actions Resource type: Deployment
Description:  Sinole Wb Wi
Entitiements
Icon: Browese...

Preview

Fecommended size: 100 x 100 pixels

Lizt wienne Catalog wview

Dretail vieww

Status: |Ac,1ive v
Quota: |Unlimrted -
Service: |dev-serwce v
=hone=
dev-zervice

9.5 Provision VM

Provision the VM from Catalog item

1. Switch to the Catalog tab.

2. Click on the Request button for the Catalog Item to be provisioned.

vmware vRealize® Automation

Administration Infrastructure

Containers

ok cancel

Home: Catalog tems Requests Ik Design

Service Catalog

Browyse the catalog for services you need.

dev-gervice (4)
Infoblox-Single-Web
m Single Web Wi

=
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3. Set deployment parameters as required and click Submit.

vmware vRealize- Automation

Catalog ftems: Requests Inkoz Design Administration Infrastructure Containers

e Request

4 [ Infoblox-Single-web Deployment Infoblox-Single-Yeb
Q) weo General Properties
Description: Single weh VM|

Infoblox-Single-Web
Single Wb Wi

Reason for request:

Deployments: 1 % (3elect 1-100)

Save | Subimit | Cancel

4. Verify that the request has been submitted successfully. Click OK.

Catalog liems Requests Inbox Design Administration Infrastructure Containers
Request
Q The request has been submitted successfully
oK
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9.6 IP Address Provisioning and DNS Registration

IP address assignment and DNS name registration in NIOS is done by the Infoblox IPAM. The following
example demonstrates the Allocate workflow process:

Whiware vRealize Orchestrator - administrator @ wra?3,

vmware vRealize- Orchestrator- G

=) Allocate

ﬁ % E; [ﬁ} I_l §chema } Events

» [Jamop
» ] 8MGP Samples
» Clazure
» [ cConfiguration
» [ Data Managemanit
» [ Data Management Samples
+ CJDynamic Types
» CIHTTP-REST
» CJHTTP-REST Samples Validate inpuits Create Endpaint Con Log resource proper
¥ Cintoklox
¥ (JwRra
» [ administration
» [ Configuration .

» [Heipers ~:/\ (7 ~4&

» [ installation {g}‘ Q/ Q/ G/
M ﬂnﬁ‘t ate 8317 14121 updateTenanthiame Get custom properti Get resource proper Put to array
+ tlocate [5/917 14:48]
+ Alocate [5/917 14:48]
 Alocate [5/917 14:45]
+ Mlocate [16:45:17)
+ Blocate [16:45.45]

+ allocate [16:45:50]

 Allocate [16:55:13] General WVariables | Logs
 Alocate [16:55:53]
+ Blocate [16:55:54] [ 7 %X 48 = [info v]

+ Allocate [17:29:54] | Messages
[2017-06-29 22:53:28.463] [1] Allocsting IP addresses in network "172 261 .0/24"
" [2017-06-29 22:58:28.954] [1] Infoblox IPAM connection: nios ga.com
Creats Endpoint Connection [2017-06-29 22:58:29.516] [1] VWAP| AP| Type. Setting empty defaut atirisutes
» Ed Creste IP Ranges [2017-06-29 22:58:20.524] [1] The IPAM netwark: 172.26.1.0/24.
» [ Delete P Ranges [2017-06-29 22:58:29.528] [1] The host to add: host name [dev-08.ga.com], MAC address [], enable DHCP [false], enable DNS [true], aliases [null.
Gel Address Spaces [2017-06-29 22:58:29.805] [1] The host with IP address [172.26.1.10], host name [dev-08.qa.com], MAC address [, enable DHCP [faise], enable DNS [true], aliases [nul] was added to PAM
Get IF Ranges [2017-06-29 22:53:29.308] [1] Automatic DHCP restart: false.
v Relsase [2017-06-29 22:58:30.604] [1] Finished allocating IP addresses in network "172.26.1 .0/24"
[2017-06-29 22:58:30.829] [1] Allocation resut
 Relsase [61347 14:31] Jestld: 60982659-dbaa-44fa-Sdae-cfdvazs 36
+ Release [18:05:54] PPAddresses: 172.261 10
+ Release [22.58:36] Rangeld: networkldefault! 72.26.1.024
+ Release [22:58:36] z“:’;‘:" f‘f -
+ Release [22:59:45] Gl;l:wa: 1";25;?1 f
> B3 Updiate DHSSuffix: qa.com
A Adtd netweark DNSSearchSutfises: null
Add range PrimaryDNS: 10.102.3.10
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IPAM details in NIOS also allow you to easily verify the IP address allocated to a provisioned VM:

Dashboards Data Management Smart Folders Grid Administration

IPAM Home
172.26.1.0/24 & Pvan
IP hlap
Gick Fitter | None v | off Show Filter
Goto Go Bl g B @R RS
|_ P Address - Mame
O £ 172.26.1.0 Used |~
] % 172.26.1.1 pfsense.ga.com U=zed t
O % 172.26.1.2 nioz ga.com U=zed :
O % 172.26.1.3 Unused
] % 172.26.1.4 prod-04 prod.com 00:50: 56: 516 4d zed t
O % 172.26.1.5 ¥CEa.08.00m U=zed t
O % 172.26.1.6 edge-infoblo:enebnat11-e33935ed-55. . =ed |
] % 172.26.1.7 dev-05.ga.com (050 56:99: 25 74 Uszed t
O £ 172.26.1.8 edge-infobloxywebnat!1-chEdE0E6-a3... Uzed |
O £ 172.26.1.9 dlev-05 g .com 00:50: 56:99: 1596 Used t
-ﬂ- 172.26.1.10 P dev-08.ga.com 00:50: 56:99:clf ol U=zed t
] % 17226411 % wray3.gqa.com Uzed t
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You will also find the DNS record registered in NIOS for the VM:

Dashboards Data Management Smart Folders Grid Administration

P2l DHCP

ga.com
I Records
Quick Fiter | Mone v | E ShowFilter  T= Togale flat view
Goto Go +- B Q- RS
Matne Recard Source comment Protected
] % S0M, Record Serial 17 System Auto-crested by .
MrAME nios.g&.com
RMAME please_set_email
Refrezh 10500
Fetry 3600
E:xpire 2419200
Megative Caching TTL 900
[ % ME Record Mo o Com System Auto-crested by .
K -3 w201 2vim Hist 17226112 Static Vs
[ % wrard Host 172261 .11 Static es
[ % wosa Host 1722615 Static Yes
] % pfaense Host 1722611 Static es
[ % nExmgr Host 172261 .20 Static Yes
K -3 micgerit-1 Hist 172261 100 Static Vs
ol dey-08 I Host 172261 10 Static Mo

9.7 De-provisioning

De-provisioning the machine will release the IP address, and also delete the IPAM data and DNS
record in NIOS.

1. Under Iltems -> Deployments, select the row for the provisioned object that you want to
terminate.
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2. Expand the Actions menu and select Destroy.

Deployments

Machines

Dep|oyment5 O by |Me v |Owner

Select an item type from the menu on the lett to viewe vour provizioned tems. Use the Actions menu to manage yvour tems.

[5) wiew petails || wiew Faent Detals [ View Compenents 40k Actions -

Hame Description Cner Expel g Change Lease
o B Infoblox-Single-veh. Single web senver Dev Admin Not }_;. Changs Cwner

Q Mame/Desctiption Q
IF Address Expires Destroy On Date Created ~
Newer Newer G/20/7, 10:58 FM

# Change Geourity

@ Destroy i

E Expire M | Destrovs a deployment and all consttuent resources.

A Saale In

A Scale Dut

3. Click Submit.

Home

MNew Request

X

4 [F] Irfoblox-Singl=-Wab Deployment Infoblox-Single-Web
) ieb
Destroy Description:  Single web server
Destroys a deployvment and all consttuent
FESOUrces
4
Reason for deployment
request:
Save Submit | Cancel

4. Click Ok.

Adminiztr

riain

Fequest

Ok

The request haz been submitted successtully.
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During this process, the Release workflow for Infoblox Plugin is called. This workflow triggers the
deletion of the IP address and DNS record in NIOS.

© Mware wRealize Orchestratar - administratar @ vra73.ga.com - [Server]

vmware vRealize" Orchestrator- X v U o« aols ¥ | Help = |

[
Q E—(}) 1 ‘E| L& Schema ‘ Events

» ] amar 4

» [ AMaP samples =T

> B are  Breese |

» [ Configuration

» [ Data Management

» [ Data Management Samples:

» [ Dynamic Types

» CJHTTP-REST

» CIHTTP-REST Samples

¥ [ infablox '
¥ [wRa - ZN\

) ! /“ Y —_— L /‘\ \

» £ Administration W (v [P

» 7 Configuration Validate inputs Credte Endpoint Con Log resource proper Get resource proper Get custom properti
+ [ Helpers

» ol instaliation
¥ B3 allocate Error handing

+F Allocate [GEAT7 14:12]

+ Allocate [GEM7 14:46] P /
+ Allocate [G8M7 14:48] —_— «— ‘./ €=
+F Allocate [GRA7 14:48] o

+ Allocats [16:4517] [\
+ Hliocate [16:45.40]

+ Allocate [16:4550] 1
+ Allacats [16:55.13] Ly General Variahles | Logs
+ Slocate [16:5553) C B
+ Aliocate [16:55:54] h /7X@ v
+ Allocate [17:29.54] Messages
+ Allocate [22:58 24] resourceld: 10299e3c-Oaal-4e77-8852-f{2448874a1a
iicindex: 0
3 Create Endpoirt Connect el
r&ate Encpaint Lonnectian [2017-06-29 23:16:49.613] [1] Releasing IP addresses allocated for NIC #0
> B treate P Ranges [2017-06-29 23:46:49.778] [1] Infoblox IPAM connection nios.ga com
> Delete I Ranges [2017-06-29 23:16:50.137] [1] Searching for host records by specified extensible attributes:
> Get Address Spaces WMware resource D EQUAL "10299e3c-0aal-4e77-9852-1f9448574a1a"
> Get IP Ranges WMware NIC index EQUAL "0"
2017-06-29 23:16:50.209] [1] The following host records were found:
v E Rl [
. eleaze dev-08.ga com/default
V Release [B817 14.31) [2017-06-29 23:16:50.577] [1] The host record [dev-DB ga.comfdefaul] was removed from IPANM.
+ Release [18:05:54] [2017-06-29 23:16:50.739] [I] Finished releasing IP addresses allocated for MIC #0
+' Release [22:58:36] [2017-06-2% 23:16:50.823] [I] Release resutt:
+ Release [22:58 36] ReleaseRequestld: 23a2ead1-b62a-4c95-80cd-fd3993255a8:
Status: Completed
ErrorCode:
ErrorMessage:
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10.NSX Load Balancer with VM Provisioning

10.1 Create Blueprint

Create Blueprint with NSX Load Balancer

New Blueprint
General NSX Seftings  Properties

*MName: | Infoblox-NSX-Web-LB

*ID: | InfobloxNSXWebLB (i
Azszign a permanent, unique 1D to this blueprint.

Description: |Infoblox NSX Web LB|

* Archive (days): | 050
Deployment limit: | ol i )
Minimum Maximum
Lease (days): | ~ | A

OK || Ccancel

Select NSX Transport Zone

New Blueprint
General  NSX Settings = Properties

These settings apply to vSphere machine components in the blueprint that have access to configured NSX networking and security settings.

Transport zone: | Global-Transport-Zone (vCenter) v | 0

Edge and routed gateway reservation policy: ] v O

App isolation @

OK | Cancel

Create a VM, set the Maximum Limit to 4 for the Instances -
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Design Canvas ® Q

¥ \Web x

(_) vSphere Machine |~

vSphere_Machine_1
General Build Information Machine Resources € Storage Network  Security Properties

*ID: | Web

Description: | Web Machine

[ Display location on request

Reservation policy: | ~ 0

Machine prefix: |prod— ~ 0
Minimum Maximum

*Instances: | 1% 130

Save Finish Cancel

Set Build Information

vSphere_Machine_1

« General  Build Information  Machine Resources  Storage  Network  Security  Properties

Blueprint type: |Senrer v O
Action: |Clone hd o
* Provisioning workflow: |CloneWnrkﬂow hd o

*Clone from: | Linux

Customization spec: |Linux |
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Add External Network

Web

General Build Information Machine Resources Storage

4 New 4 Edit | X Delete

ID & Network Assignment Type
0 InfobloxExternal Static IP
Maximum network adapters: 30

Add Network to the VM

vSphere_Machine_1

General Build Infarmation Machine Resources Storage

ok Mews o Edit | 3¢ Delete

Network Security Properties

Address Load Balancing Custom Properties

Metwork Security Froperties

D & etk Azzignment Type Address

o InfobloxIPAME-ternal Static IP

10.2 Add Load Balancer

Drag and drop ON Demand NSX Load Balancer to the canvas

Design Canvas

@ InfobloxExternal

On-Demand_Load_Balancer_1

General §

*ID: |On-Demand_Load_Balancer_1

¥ Web

@& On-Demand_Lo.. X

) vSphere Machine

*VIP network: v| a

* Machine: |

v| IP address: i ]

* Network adapter: |

vlﬂ

Virtual servers:

# Edit

Enable Load Balancing for the desired protocols:
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On-Demand_Load_Balancer_1

General
*ID: | On-Demand_Load_Balancer_1 *VIP network: |InfobloxExternal v |0
*Machine: | Web v IP address: (i ]
* Network adapter: |Q:InfobloxExternal ~ @
Virtual servers:
# Edit
Name Port Algorithm Heailth Check Interval (sec)
HTTP 80 ROUND_ROBIN 5
HTTPS 443 ROUND_ROBIN 5
TCP 8080 ROUND_ROBIN 5
-
Web

General Build Information Machine Resources Storage Metwork Security Properties

Property Groups Custom Properties

Description

Infobilox-Default Infoblox Default Property Group

The following example demonstrates how the completed blueprint will appear:

¥ ‘Web
@ On-Demand_Lo... =----gi-

) vSphere Machine

|

& InfobloxExternal

10.3 Publishing the Blueprint
Blueprints must be published before they can be assigned to a catalog item. To publish the blueprint:

1. Navigate to Design -> Blueprints.
2. Click on the row for your blueprint (taking care not to click on the hyperlink).
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3. Click on the Publish button.

Blueprints
Create and manage blueprints. Publish a blu to allow architects to reuse your blueprint, and to allow catalog administrators to entitle users to request your blueprint from the
catalog.

& New & Edit [[5Copy ) Publish X Delete

MName Description Status Last Modified

Infoblox-Single-Web Infoblox Single Web VM Draft 11372017, 8:44:30 PM

Docker - Photon0 3 Sample template for provisioning Docker ho...  Published 132017, 12:20:26 PM

Docker - CoreQ 5 Sample template for provisioning Docker ho... Published 132017, 12:20:26 PM

4. Verify that the status for the blueprint has changed to “Published”.

Blueprints
Create and manage blueprints. Publish a blueprint to allow architects to reuse your blueprint, and to allow catalog administrators to entitle users to request your blueprint from the
catalog.

4 New & Edit [ Copy ] @ Unpublish | X Delete

MName Description Status Last Modified

Infoblox-Single-Web Infoblex Single Web VM Published 1/3/2017, 8:44:30 PM

Docker - PhotonO5S Sample template for provisioning Docker ho...  Published 11372017, 12:20:26 PM

Docker - Core0 5 Sample template for provisioning Docker he...  Published 12017, 12:20:26 PM

10.4 Assign the Catalog item to a service

Published blueprints become available as catalog items. These must be assigned to a service and entitled to a
business group before they will be available in the Service Catalog. To assign your catalog item to a service:

1. Navigate to Administration -> Catalog Management -> Catalog Items.
2. Click on the hyperlink for your catalog item, or select its row and click Configure.

Hotne Catalog = 3 Ik Design Administration ture Cortainers

Catalog ltems

¢ Addministration

Catalog items are published blueprints, Xaas blueprints, and software components. These blueprintz and components are publizhed on the Design tab or using the vRealize
Automation AP1. To make a catalog tem available inthe service catalog, add the tem to & service and then enttle the catalog temn to s business group. Softwsare components

Services can alzo be entitled to enforce approval policies, but they can only be requested az part of a blueprint. If you unpublizh & catalog tem, it will no longer be svaiable in the
service catalog.

Catalog tems Advanced Search ¥

= 8]
(BT Mame = Statuz Source Resource Type Scope Appearsin Catalog Senice De...

Infoblox-SingIe-Wé? Fublished Blueprint Senice Deployment Shamd ez Singl
Ertitlemerits

3. Expand the Service dropdown menu and select the service that you want to assign to the catalog item.
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Haome

4. Click OK.

¢ Administration
General Ertitlements
Services
Hame:
Catalog ems
Source:
Actions Resource type:
Description:
Ertitliements
leon:
Preview
Status:
Quota:
Service:

Acministration

Configure Catalog Item

Infoblox-Single-Wek
Blueprint Service
Deployment

Single Wik W

Broveese...
Recommended size: 100 x 100 pixels

Lizt wiew Catalog view

Dietail vigewr

|active v
[Unlimitest -
| -
=haones=
dev-service I}
Ok Cancel
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Configure Catalog Item
General  Entitiements
Name: Infoblox-NSX-Web-LB

Source: Blueprint Service

Resource type: Deployment

Description:
Icon: ;— Browse...
Recommended size: 100 x 100 pixels
Preview Listview Catalog view Detail view

Status: | Active

Quota: | Unlimited
Service: ibrod-service

(| Newand noteworthy

Catalog item will appear in the Service Catalog
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Catalog ltems Requests Inbox Design Administration Infrastructure Containers

Service Catalog

Browse the catalog for services you need.

Production-Service (2)

Infoblox-N SX-Web-LB Infoblox-Single-Web
Infoblox MSX Web LB Infoblox Single Web M

Reques

10.5 Deploy from NSX Web Blue catalog item.

Deploy the item —

4 [} infoblox-NSX-Web-LB Deployment: Infoblox-NSX-Web-LB

k-—' Web General Froperties

Description: |Infoblox Prod Web Demo

Reason for request:

Deployments: | 1 5| (Select 1-100)

Home Catalog ltems Requests Inbox Design Administration Infrastructure Containers

ﬁequests

Monitor the status of your requests and view request details.
D iew Details X Delete
Request ltem Diescription Cost Lease
B B Infoblox-NSX-Web-LB Infoblox Prod Web Demo Not Applic able Not A
7 B infoblox-Single-Web Prod demo #1 Not Applic able Not A
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Tools v| Help v|

Setup Wizard

J Schema ‘ Events

» O Helpers
¥ [ Installation
» [ IPAM registration
» [JwRO customization
v E3 setup Wizard
Setup Wizard [14
v Ed Allocate

+ Allocate [20:54:47]

" Allocate [21:24:11]

" Allocate [21:24:43]
Create Endpoint Connection
Create IP Ranges
Delete IP Ranges

> Get Address Spaces Initialize
» Ed Gat P Ranges !
v Release

+" Releaze [21:06:57]
» EJ update IPAM records
Add network
Add range
Remove DHCP record
Remove DNS record :‘k >
Remove host record

Remove network General Variables | Logs
Remove range
Rezerve IP address |1 /’ X @& = |Info L 4

Reserve IP in network
Meszages

Reserve IP in range successiully!
Restart IPAM services [2017-01-03 14:38:22.360] [1] Property definition “Infoblox.IPAM. Network1.comment’ was not found.
» C]JDBC [2017-01-03 14:38:22.386] [I] New property definition ‘Infoblox.IPAM. Network1.comment' was created

» 71 Locking successfully’

Setup Wizard

|

i

|

|
¥

10.6 IP Address Provisioning and DNS Registration

Edge and VM gets IP address assigned

IPAM e e

IPAM Home
172.26.1.0/24 ¢ PvaNetwork # #r Goto DHCP View

Quick Fiter | None v | Ed | showFitter

Go to Go

IP Address « ype

O & 172.26.1.0 Used IPv4 Network
O & 172.26.1.1 Router Reservat... Used IPv4 Reservation DHCP
O & 172.26.4.2 nios. poc..infoblox .. Used A Record DNS
O & 172.26.1.3 pfsense.poc.info... Used Host DNS
- & 172.26.1.4 prod-04.prgghcom  00:50:56:8d:16:4d Used Host ONS
O & 172.26.1.5 vCS obio... Used Host DNS
] & 172.26.1.6 edge-infobloxns.. Used |Pv4 Reservation DHCP
] & 172.26.4.7 prod-05.prod.col :50:56:8d:8e-fe Used Host DNS
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Zones Members MName Server Groups Shared Record Groups Blacklist Rulesets DNSE4 Groups Query Monitoring

default
prod.com  Authoritative Zone @/ B

l Records Subzones

Quick Filter | Mone v | | Show Filter = Togagle flat view

Go to Go

& Name = Type Data Record Source Principal Protected

[ - ; SOA Record Serial 28 System
MMNAME nios.pot infobloxe
RMNAME please_set_email
Refresh 10800
Retry 3600
Expire 2419200

Megative Caching TTL 900
NS Record nios . poc infobloxdemo.com System
prod-05 Host 172.261.7 Static Mo

Check the provisioned machine in vSphere client, it will have the IP address provided by NIOS

vmware* vSphere Web Client #=

Navigator X (3p Edge-InfobloxN SXWebLB-81395fee-aa%4-..  Actions v

| <4 Home 1O Getting Started | Summary | Monitor Manage Related Objects
| @ | @ 8 2]
w [Z vesa poc.infobloxdemo.com

w [iq Infoblox

v ﬁ Compute VMw are Tools: Running, version:2147483647 (Guest Managed)
E compute-1.poc.infobloxdemo.com DNS Name: NSX-edge-8-0

[ &3 Edge-InfobloxNSXWebl B-81395fee-3ad4-4410_. ) . PAddresses:  17226.1.6

Edge-InfobloxNSXWebLB-81395fee-aa%94-4410-8327-5d88d8bd83ec-0
Guest OS: Other Linux (84-bit)
Compatibility ESXi 5.5 and later (VM version 10)

{5 prod-05 View all 4 IP addresses
{5 Web-01 Launch Remote Console Host: ¢compute-1.poc infobloxdemo.com
» §J Momt Download Remote Console @ A

Production Linux VM has also received IP address from NIOS

vmware* vSphere Web Client A=

Navigator X 3 prod05 @ Actions -

4 Home O] Getting Started | Summary | Monitor Manage Related Objects
[ | ® B8 a

prod-05
w [ vesa. poc.infobloxdemo.com Guest 0S: Red Hat Enterprise Linux & (32-bit)
| - Infoblox Compatibility : ESXi 5.0 and later (/M version 8)
- ﬁ Compute “Mw are Tools: Running, version:9226 (Upgrade available)

g compute-1.poc.infobloxdemo.com DNS Name: prod-05

ﬁbEd{_:e—lnfoblaxNSK"."\-'ebLE—S'3951’99—3894—44‘0... IP Addresses:

w prod-05 b View all 2 IP addresses

Eb'."v'eb-ﬂ' Launch Remote Console Host: compute-1. poc infobloxdemo.com
| » P Mgmt Download Remote Console @ A
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10.7 De-Provisioning

Destroy the machine from items

Home Catalog tems Requests Inbox Design Administration Infrastructure Containers
D bkaate Deployments
Select an item type from the menu on the left to view your provisioned items. Use the Actions ment
Machines View Details |-| iew Parent Detais g3 View Components | §0% Actions +
Name Description ¢ &) Change Lease
» [ infoblox-NSX-Web-LB-02 Demo LB 1 Y % Change Owner
© Destroy
(@) Expire
& Scaleln
/  Scale Out

Destroy the item

Destroy - Infoblox-NSX-Web-LB-02396829

9 Destroys a deployment and all constituent resources.

Are you sure you wish to continue?

Submit Cancel

This will release the IP addresses assigned to Edge and VM’s and will delete the DNS registration for
the VM’s.

11. Routed Network Profile

VMware VRA 7.3 provides integration with Infoblox NIOS to created Routed Networks. This section
describes how to create Routed Networks using Infoblox VMware VRA 7.3 integration.
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11.1 Add Network Container in NIOS
Add Network Container in NIOS that will be used for Routed Network Creation. Below, we are creating network
container 10.10.0.0/16.

Add IPv4 Network Wizard > Step 1 of 6
(e
Add Network

Manually
Using a network template Select Template

# Add Network Container

Cancel Previous MNext Schedule for Later Save & Close -
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Add IPv4 Network Wizard > Step 2 of 4 B

Netmask* 114l | 124(255.255.255.0 )

i 4 8 12 16 el
trrrrrrrrerrrrrrrrrntd

24
|
[ s ]

Network Containers =

[#] 10.10.0.0

+* v Q

Comment

Delegate authority from the Grid Master

Delegated To

Select Clear

Cancel Previous Mesxt

Schedule for Later

Save & Close -
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Add IPv4 Network Wizard > Step 3 of 4 B
e

®
Extensible Attributes + | &
Aftribute Name  Value Inheritance State  Required
Mo data
Cancel Previous Mext Schedule for Later Save & Close -
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Add IPv4 Network Wizard > Step 4 of 4

Create IPv4 Network
® Now
) Later

Selected time:

Start Date IED16—12—16 Start Time | 09:41:10 PM ’LLJ Time £one

Your time: 2016-12-16 0 42:53 PM (UTC - 8:00) Pacific Time (US and
Canada), Tijuana

R

Cancel Previous MNext Save & Close -

This will create the Network container

Dashboards Data Management Smart Folders Administration

DHCP DMS File Distribution

default  NetworkView #r

Quick Fiter | None vl E | Show Filter = Toggle flat view
| MNetwork « Cloud Usage Owned By Delegated To Comment IPAM Utilization

O % [ 10.10.0.0116 Mon-cloud Grid 0.0%
O e 11.11.11.0/24 MNon-cloud Grid 0.0%
O e 172.26.1.0/24 Mon-cloud Grid I 3.5%

11.2 Create External Network Profile in vRA.

Routed Network Profile requires the External Network profile. Create the External Network Profile.
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ware vRealize® Automation

Home Catalog [tems Requests Inbox Design Administration Infrastructure

MNetwork Profiles

Metwork profiles specify network settings in reservations and blueprints. N

Key Pairs & Ea | =

@ edema |

Reservations Bl naT

Q Routed

¢ Infrastructure

Reservation Paolicies

Metwork Profiles

vmware vRealize Automation

Home Catalog tems Requests Inbox Design Administration Infrastructure Containers

New Netwark Profile - External

Create a network profile to manage one or more named ranges of static IPv4 network addresses.

¢ Infrastructure

Key Pairs General Metwark Ranges

*Name: |Infoblox-External-1
Reservations

Description: | INFOBLCX Extarnal

Reservation Policies

Network Profiles IPAM endpoint: | NIOS ~ D
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New Network Profile - External

Create a network profile to manage one or more named ranges of static IPvd network addresses.

General Network Ranges

Address space: |default v D
db Add | 3 Remove
Start IP End IP Name
Select Network Range *
|_& 0
Start IP « End IP Name Description
11111141 11.11.11.254 1M.11.11.0v24
1722611 172.26.1.254 172.26.1.0v24
|4 4 | Page |1 oft| b B | @ Displaying 1 -2 of 2
Ok Cancel

Above we use 172.26.1.1 as the network to be used in External Network Profile.

New Network Profile - External
Create a network profile to manage one or more named ranges of static IPv4 network addresses

General Network Ranges

Address space: default

4k Add | X Remove
Start IP ~ End IP Name
1722611 172.26.1.254 172.26.1.0i24

Network Profiles

Network profiles specify network settings in reservations and blueprints. Network profiles are used to configure network interfaces when VMs are provisioned, and to specify the

& New- & Iy | %
Type Description
Infoblox External

Name
Infoblox-External-1 External
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11.3 Create Routed Network Profile

Create a new routed profile
Network Profiles

Metwork profiles specify network settings in reservations and blueprints. Network profiles are used to configure network interfaces when VYMs are provisioned, and to sped
7 cx Dycom | x
& External Type

Description
ﬂ’ NAT External

Infoblox External
&% Routed

New Network Profile - Routed

Create a network profile to manage one or more named ranges of static IPvd netwark addresses.
General IP Blocks

*Name: |Infnh|nx—F€nuted—1

Description: |Infoblox Routed 1

IPAM endpoint: | NIOS

v O
* External network profile: |Infoblox-External-1 v O
* Range subnet mask: |255.255.255.D V|ﬂ

Select the 10.10.0.0/16 Network block.
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New Network Profile - Routed

Create a netwaork profile to manage one or more named ranges of static IPv4 network addresses.

General IP Blocks

Address space: |default i)
Select IP Block X
Search S ]
Start IP ~ End IP Name Description
10.10.01 10.10.255.254 10.10.0.0M6

I4 .|Page|1 oft | b b |

Displaying 1 - 1 of 1

OK Cancel

Network Profiles

Metwork profiles specify network settings in reservations and blueprints. Metwork profiles are used to configure network interfaces when Viis are provisioned, and to spe

g New~ i | =

MName = Type
Infoblox-External-1 External
Infoblox-Routed-1 Routed

11.4 Add Network Profiles to the Reservation

Description
Infoblox External
Infeblox Routed 1

Create a new reservation or add Network profile to existing reservation. Here we are creating a new

reservation.
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New Reservation - vSphere (vCenter)
Create a resernvation to allocate provisioning resources to a business group in a tenant. You also can co

General Fesources Metwork Froperties  Alerts

*Mame: ‘Prnductiun—ﬁesewatinn

* Tenant: ‘vsphere.lncal h

*Business group: ‘prnductinn—husiness—grnup hd

Reservation policy: ‘ w
* Priority: 13

Enable this reservation

New Reservation - vSphere (vCenter)
Create a reservation to allocate provisioning resources to a business group in a tenant. You also can copy an existing reservation to use as a starting point.

General Resources  Network Properties  Alerts

Network: Network Adapter Network Profile

dvPortGroup

O

dvSwitc h-DVUplinks-43

O

WM Network Infoblox-External-1 v

€l

vxw-dvs-43-virtualwire-3-sid-5001-Transient-Switch

O

vxw-dvs-43-virtualwire-8-sid-5000-Web-Switc h

O O

vxw-vmknic Pg-dvs-43-0-03dbfd73-14ac-4c d0-8850-60e18f4cflca

Advanced Settings

Transport zone: |Globa\-Transpnrt-Zone hd

Security groups: Activity Monitoring Data Collection

Distributed logical Name Network Profile
router:

Logical-Router-01 Infoblox-External-1 hd
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New Reservation - vSphere (vCenter)

Create a reservation to allocate provisioning resources to a business group in a tenant. You also can copy an existing reservation to use as a starting point.

General Resources Network  Properties  Alerts

* Compute resource: i Compute (vCenter)

Machine quota: ‘ Uniimited £ @
“Memory (GB):  Physical Total Reserved Total Alloc ated This Reservation
10 0 0 k 57
* Storage (GB): Storage Path Physical Free Total Reserved This Reservation Reserved This Reservation Alloc ated Priority Disabled
@ datastore1 (1) 82 e 0 204 [ y & [
OK Cancel
Resource pool: \ v
11.5 Create Blue Print
Create Blue Print that uses the Network Profile
New Blueprint [x]
General MNSX Settings Properties
*Name: | Infoblox-Web-Routed-1
*ID: | Infoblox\WebRouted 0

Assign a permanent, unique 1D to this blueprint.

Description: |Infoblox Web Routed Design
* Archive (days): | 00
Deployment limit: | 20
Minimum Maximum
Lease (days): | c | 3

OK

| Cancel

© 2017 Infoblox Inc. All rights reserved. Infoblox IPAM Plug-in 4.3.0 for VMware VRA 7.3 Deployment Guide  June 2017 Page 86 of 147



New Blueprint [x]
General NSX Settings Properties

These settings apply to vSphere machine companents in the blueprint that have access to configured NSX networking and security settings.

Transport zone: | Global-Transport-Zone (vCenter) v | i ]

Edge and routed gateway reservation policy: | w 0

App isolation

oK || cancel

Design Canvas

¥ Web x

() vSphere Machine

vSphere_Machine_1
General Build Information Machine Resources € Storage Network  Security Properties

"ID: |web

Description: |Web Blue Print

Display location on request @

Reservation policy: | v O

Machine prefix: |prod- v 0
Minimum Maximum

*Instances: | 13 120
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Design Canvas

vSphere_Machine_1

General  Build Information

Blueprint type:

Action:

* Provisioning workflow:
*Clone from:

Customization spec:

Machine Resources  Storage Network

Security ~ Properties

Server v 0
Clone v 0
CloneWarkflow v 9
Linux
Linux

Add Property Group to the VM
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Design Canvas

Add Property Groups %] »
Name « Description
Container host properties with certific ate authe... Sample property group with custom properties for container host using certific ate and private key f..
Container host properties with user/password ...  Sample property group with custom properties for container host using user and password credent...
Infoblox-Default
0
[4 4 | Page ‘1— of1| b bl | @ Displaying 1- 3 of 3
vSphe
Genel oK || cancel

Property Groups = Custom Properties

add
& Add

Name Description

[£) view Merged Properties | @

Add Routed Profile to the Canvas

* ‘Web

) wSphere Machine

& Dn—Demand_Rnu...x
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Design Canvas

Select Network Profile
Name

Infoblox-Routed- 1

Description
Infoblox Routed 1

| |Page |1 |of1| b | @

IPAM Endpoint

NIOS

OK

ED

Sphere Machine

Displaying 1 - 1 of 1

Cancel

On-Demand_Routed_Network_1

General @ = DNS/WINS
“ID:
* Parent network profile:

Description:

IP Ranges

On-Demand_Routed_Network_1
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Design Canvas

¥ Web x

=) vSphere Machine

@& InfobloxRouted1

Web

General Build Information Machine Resources  Storage Network = Security  Properties

o # Edit | X Delete
ID ~  Network Assignment Type Address
0 InfobloxRouted1 w | Static IP
OK Cancel
Maximum network adapters: Unlimited 3| @
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Design Canvas

Web

General Build Information Machine Resources

4k New ¢ Edit | X Delete
ID « Metwork

0 InfobloxRouted1

Maximum network adapters:

Publish the Blueprint to a service
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¥ Web x

) vSphere Machine

Lo
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ware vRealize~ Automation

Catalog tems Requests Inbox Design Administration Infrastructure Containers

Service Catalog

Browse the catalog for services you need.

Production-Service (1)
Infoblox-Web-Routed-1
Infeblox Web Routed Design
Request
11.6 Provision a Routed VM
Provision the catalog item
4 ] nfoblox-Web-Routed-1 Deployment: Infoblox-Web-Routed-1
0 Web General Properties

Description: |[Demo 1

Reason for request: |Demo Request 1|

Deployments: | 1 3| (Select 1-100)

This will trigger Infoblox Create IP Ranges workflow in VRO.
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¥ [ Infoblox
v CvRA
» | Administration
» ] Configuration
» [ Helpers
» [ Installation
Allocate
Create Endpoint Connection
¥ Create IP Ranges
" Create IP Ranges [22:12:28]
L ™occtePRanges |
L Get Address Spaces
» EJ Get IP Ranges
Releaze
Update IPAM records

New Network will automatically get created in NIOS container

Grid Administration

Dashboards Data Management Smart Folders

DHCP DNS File Distribution

IPAM Home
10.10.0.0/16 E= 1Pv4 Network Container
MNet Map
Quick Fiter[Nore v | | ShowFiter %2 Toagle fiatview
Go to Go
|_ Metwork « Cloud Usage Owned By Delegated To Comment IPAM Utiiization
D ﬁ mikp 10.10.0.0/24 Cloud from adapter Cloud adapter Automatically cr.... 0.0%

This will also trigger Infoblox Workflow in VRO to get IP address from this network
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¥ [ infoblox
¥ OvRA
» | Administration
| Configuration
| Helpers
» [ Installation
¥ Allocate
Allocate [22:13:03
Create Endpoint Connection
¥ Create IP Ranges
" Create IP Ranges [22:12:28]
Delete IP Ranges
> Get Address Spaces
> Get IP Ranges
Releaze
Update IPAM records
Add network
Add range
Remowve DHCP record
Remowve DNS record
Remove host record
Remowve netwaork
Remove range
Reserve IP address
Reserve IP in network
Reserve IPin range

n Dactart IDAM caonriroo

The provisioned VM will have IP address assigned from the routed network

Data Management Smart Folders Grid Administration

DHCP DNS File Distribution

IPAM Home > 10.10.0.0M6

10.10.0.0/24 ++ Cioud IPv4 Network /# #*;  Goto DHCP View

Quick Filter | None v Show Filter
Go
] & 10.10.0.0 Used IPv4 Network
1 & 10.10.0.1 Used IPv4 Reservation DHCP
[l ﬁ 10.10.0.2 prod-03.prod.com Used Host DNS

Routed interface is automatically added in DLR
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Logical-Router-01-0

| Getting Started

EMuE i Resource Allocation | Performance | Tasks & Events | Alarms | Console | Permissions | Maps

vSphere HA Protection: (& Nja B2

Commands

Shut Down Guest
I Suspend

@ Restart Guest
E Open Console

Er,ﬂ Migrate

&@ Clone to New Virtual Machine

General Resources

Product: vShield Edge Consumed Host CPU: 71 MHz

Version: 6.2.3-3348215 Consumed Host Memary: 293.00 MB

Vendor: VMware, Inc. Active Guest Memary: 128.00 MB

Guest 05: Other 3. or later Linux (4-hit) Refresh Storage Usage

VM Version: 10 Provisioned Storage: 715.38 MB

CPU: 1 vCRU Not-shared Storage: 552.00 MB

Memory: 512 MB Used Storage: 715.38 MB

Memory Overhead: Storage ’ | Stakus | Drive Type

VMware Tools: (3 Running {Guest managed) B datastorel & MNormal Mon-550

IP Addresses: 10.10.0.1 View all " o "
Virtual Machine IF Addresses | ks

DMS Mame: Logical-Router-01-0

EVC Mode: NjA IP Addresses: o ]

10.10.0.1 up ]

State: Powered On

Host: mamt-1.poc.infobloxdema. com 121212253 P @

Active Tasks: IPv6 Addresses: 5

fel0:848b d%f fec2bb07
fe8l: 4b8:53f fe11:238a
fel0::250.56f feBd. 28083
fe80: 25056/ feldc b4

Annotations

VEM Owner:
vrmManagedMa. ..
MNotes:

& Edit

Provisioned machine has IP address from the Network
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= (5 vesa.poc.infobloxdemo.com
B [Fg Infoblox
=l fR Compute
[@, compute-1.poc.infobloxdema.com

B magmt-1.pocinfobloxdemo.com

(fs Edge-Gateway-01-0

(T3 Logical-Router-01-0

@ NSX_Controller_f73e170a-5d85-4090-8a62-42594fb40d0a
(T3 Nsxmgr-623

prod-03
Getting Started @yl El' Resource Allocation | Performance
General
Guest O5:
VM Version: 8
CPU: 1wCPU
Memory: 123 MB

Memory Overhead:

YMware Tools: /% Running {Out-of-date)

IP Addresses: 10.10.0.2

DMNS Mame:

EVC Mode: N/A

State: Powered On

Host: compute-1.poc.infobloxdemo. com
Active Tasks:

vSphere HA Protection: (3 Nja &

DNS registration is also done by the Infoblox workflow

IPAM DHCP L EY Fie Distribution

Zones Members MName Server Groups Shared Record Groups
default
prod.com  Authoritative Zone @l /" Br

Bilacklist Rulesets

DN564 Groups

Query Monitoring

Quick Fiter [Nore v | | ShowFiter T2 Toagle fiatview
Go to Go
| Name a Type Data Record Source Principal Protected
o SOA Record Serial 20 System )
MMAME nios . pot .infoblox¢
RMNAME please_set_email
Refresh 10800
Retry 3600
Expire 2419200
Megative Caching TTL S00
fol NS Record nios .poc infobloxdemo.com System '
o prod-03 Host 10.10.0.2 Static No

vmware vRealize Automation

Home Caialog Requests Inbox Design

Deployments Deployments

Administration Infrasiructure Containers

Select an item type from the menu on the left to view your provisioned items. Use the Actions mer

Machines

E

Mame

E

i [ infoblox-Web-Routed-1-1
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11.7 De-provisioning

When the provisioned item is deleted, it will trigger the workflow to release the IP address back to the
pool and delete the range that was created.

vmware vRealize- Automation

Home Catalog Requests Inbox Design Administration Infrastructure Containers
B Deployments
Select an item type from the menu on the left to view your provisioned items. Use the Actions menu to manage your items.
Machines View Details =] View Parent Details  fg View Components | 0% Actions ~
Name Description q ':_:] Change Lease Costto Date Compo
b Infoblox-Web-Routed-1-1 Demo Routed Request Y % Change Owner Not Applic able
‘ o Destroy I
(@) Expire
@ =p Destroys a deployment and all constituent
# Staleln | fesources.
/ Scale Out

Destroy - Infoblox-Web-Routed-1-18308709

0 Destroys a deployment and all constituent resources.

Are you sure you wish to continue?

Submit Cancel

This will call Infoblox Workflow to release the IP address for the VM
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¥ £ Infoblox
¥ vRa
» [ Administration
| Configuration
» [ Helpers
» [ Installation
A\l Allocate

Allocate }
Create Endpeint Connection

A\l Create IP Ranges

" Create IP Ranges [22:12:28]
» EJ Delete IP Ranges
> Get Address Spaces
» Ed Get P Ranges
A\l Releaze

" Release [22:56:00]
» E3 update IPAM records
Add network
Add range
Remove DHCP record
Remowve DNS record
Remove host record
Remowve network
Remove range
Reserve IP address
Reserve IP in netwaork
Reserve IP in range
Restart IPAM services

=

This will then trigger the workflow to delete the provisioned range
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¥ [ infoblox
¥ CvRa
* [ Administration
L | Configuration
» [_]Helpers
» [ Installation
v Ed Alocate

Allocate ;
Create Endpeint Connection

v Create IP Ranges

" Create IP Ranges [22:12:28]
v Delete IP Ranges

" Delete IP Ranges [22:56:50]
* Get Addrezs Spaces
» E Get IP Ranges
v Releaze

+ Release [22:56:00]
» E3 update IPAM records
Add network
Add range
Remove DHCP record
Remowve DNS record
Remove host record
Remove network
Remove range
Reserve IP address
Reserve IP in network
Reserve IP in range
Restart IPAM services

Range gets deleted in NIOS

Administration

Dashboards Data Management Smart Folders Grid

DHCP DNS File Distribution

IPAM Home

10.10.0.0/16 5= iPv4 Network Container

Net Map

Quick Fiter | Mone v | | show Fiter T Toanle fiat view

Go to Go

|_ Metwork Cloud Usage Owned By Delegated To Comment

M data

Workflow also deletes the Host record in DNS.
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Dashboards Data Management Smart Folders Grid Administration

File Distribution

Zones Members Name Server Groups Shared Record Groups Blacklist Rulesets DN564 Groups Query Monitoring

default

prod.com  Autheriative Zone (@ P ]

Quick Fiter[None ] | | ShowFiter T Toaale fiatview
Go to Go
| [ Name « Type Data Record Source Principal Protec ted
] % S0A Record Serial 21 System
TMMAME nios . pot infobloxe
RMNAME please_set_email
Refresh 10800
Retry 3800
Expire 2415200

Megative Caching TTL 200
[ - ; NS Record nios.pot infobloxdemo.com System

12. NAT Network Profiles

12.1 Create One to One NAT Profile

The network profile sets the network parameters that will be used when deploying an instance in a One to One
NAT configuration.

1. Inyour vRA tenant, navigate to Infrastructure -> Reservations -> Network Profiles.
2. Click New and select NAT.

vmware vRealize Automation

Harme & | ltems= Req 3 Inkox Design Administration Infrastructure

 Infrastructure Network Profiles

Metwork profiles specify network settings in reservations and hlueprintz. Metwark profiles ar

Key Pairs ok ew v | 7 | x

& External Type
Reservations |n hAT |

@ Routed

Reservation Policies

Hetwork Profiles

3. Complete the fields in the “New Network Profile - NAT” configuration, being sure to set the
IPAM endpoint menu to your Infoblox NIOS IPAM endpoint and NAT type to One-to-One.
a. Note: The External network profile selected here must contain only one network or
network range and have at least two available IP addresses.

© 2017 Infoblox Inc. All rights reserved. Infoblox IPAM Plug-in 4.3.0 for VMware VRA 7.3 Deployment Guide  June 2017 Page 101 of 147



Mewy Metwork Profile - AT

Creste & netwiark profile to manage one or more named ranges of static IPvd network addrezses,

General DS Metwork Ranges

*Hame: ||nfikilog-1-1-NAT-Profile

Description: |Infoblox One to One MAT Profile

IPAM endpoint: | |nfoblox L
“External network |\ ;o Eoternal 172 26 1 0524 L
profile:

*HAT type: |One-to-One "

*Subnet mask: |255 2552550 v
*Gateway: 1010101 o

DHCP
ok Apply Cancel

Switch to the DNS tab. Optional: Enter DNS settings here to override the DNS settings from NIOS.
Switch to the Network Ranges tab.

Click New and provide a name, description (optional), Start IP address and End IP.

Click OK to save the network range.

Click OK to save the network profile.

© N

New Network Profile - NAT

Create a network profile to manage one or more named ranges of static IPv4 network addresses.

General DrE Metwork Ranges

dp Mew & Edit X Delete | g Import from C5%

[Maime Description Start P~ End IP
rangel 104010130 10401041 80|
ks Cancel
(0174 Apply Cancel

The Machine Blueprint sets the design for instances that are being deployed. This section describes the steps for
creating a blueprint used to create instances in a One to One NAT configuration.

1. Navigate to Design -> Blueprints.
2. Click New to create a Single Machine blueprint.

© 2017 Infoblox Inc. All rights reserved. Infoblox IPAM Plug-in 4.3.0 for VMware VRA 7.3 Deployment Guide  June 2017 Page 102 of 147



Hew Blueprint *

General MEX Settings Froperties

*Name: |Infoblox ek 1-1 MAT

®

D: | InfabloxtiehlT AT 0
Azzign & permanent, unigue 10 to this blueprint

Description:

Deployment limit: 30

Minimum Maximum

Lease (days): o bl ]

* Archive (days): i ]

Ok Cancel

3.  Under the NSX tab, set the Transport zone to be used for the NSX connection.

Hew Blueprint x

General HSZX Settings Froperties
These settings apply to vSphere machine components inthe bluegprint that have sccess to configured NSX networking and security settings.

Transport zone: el ]

Edge and routed gateway reservation policy:
global-transport-zone (vCenter) ‘{b 0

[ Lpp isolstion €

Ok Cancel

4. Click OK.
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5. Here we have the machine blueprint named “Web” and selected machine prefix “prod-*

De[}}gn Canvas

v Sphere_Machine_1

General Build Information
"ID:

Description:

Reservation policy:

Machine prefix:

" Instances:

¥ Web x

_) vSphere Machine

Machine Resources €0 Storage  Metwork
Web

Web VM

[C] Display location on reguest i

prod-

Minimum Maximum

<>

6. Setthe Build Information:

Security  Properties

Save Finish

@ Q

Cancel

vSphere_Machine_1

«  General Build Informatio
Blueprint type:
Action:
* Provisioning workflow:
" Clone from:

Customization spec:

n Machine Resources Storage MNetwork
Server

Clone

CloneWorkflow

Linux

Linux

Security Froperties
v 0
L
v 0

7. Inthe Categories panel, select Network and Security (1).
8. Inthe bottom left panel, drag the Existing Network button (2) to the Design Canvas (3).
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MNew Blueprint Infoblox \Welb 1-1 MAT 4

Categories Design Canvas
25 machine Types
i Sofhware Components
B3 Blueprints 1
|_(,_" Metotk & 5 ecurity

-'_'a)(aaS
.:Containers

Configuration Management
F. g g

& Other Components
Search Q

& Container Hetwark 2

| & Existing Netwark

Existing Security Group
Existing Security Tag
ﬂ On-Demand Load Balancer LY
Bl on-pemand MAT Metwod L
ﬁ On-Demand Routed Mehwark ~
o On-Demand Security Group \‘

3

% Exizting_Metwork_1

@ Q

ek

) wEphere [vCente...

Save Finizh Cancel
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9. Click on the Existing_Network icon in the Design Canvas (1) and then the selector button for
“Parent network profile” (2).

Mew Blueprint Infoblox Wyeb 1-1 MAT 48

Categories Design Canvas @ @
[ZE] Machine Types

i Software Companents
Ellueprints ¥ Wik

() Metwark & Security

J; Saas

.:_Containers

rn. Configuration Management

& Other Components 1) wEphere [vCente...

Search S
@ Existing_Metwork_1% &

@ Container Mehuok -
Existing_Hetwork_1

& Ewisting Hetwark
Existing Security Group General @  DHNSWINS P Ranges

Existing Security Tag * Hetwork profile:

ﬁ On-Cremand Load Balanocer

Description:
EL on-Demand HAT Network

Q, On-Lemand Routed Metwad

o On-Demand Security Group

Save Finizh Cancel

10. Select the one to one NAT network profile created previously and click OK.

Select Network Profile X
Marme Description IPAM Encipoint
Initobiox -E:xcharmal Marmy Infokioc
Irifobilon-RLAT-1 <1 b Infobloo:
Page 1 af1 2 Displaryving 1 - 260 2
Ok Cancel
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Design Canvas. @ Q

¥ Web

vSphere (vCente...

x

B InfobloxNAT1 .

InfoblozNAT11
) Gemeral ~DNSMWINS  IF Ranges

“ID: | nfoh oAAT 11
* Parent network profile: | iohl i MAT-1-1
Description:
1PAM endpoint:  Infolilox
External network profile: - InfobloxExternal-172.26.1.0124
NAT type: One-io-One

Subnet mask: 255.255.255.0

Save Finish Cancel

11. Click on the icon for your machine in the Design Canvas and switch to the Network tab.
12. Click + New.

13. Expand the dropdown menu under the Network column and select your One to One Nat network
profile.

Design Canvas

¥ b x

vSphere (vCente...

B InfobloxtaT 11 L]

Weh

General  Build Information  WMachine Resources  Storage | Metwork | Security | Properdies  Profiles

q9e Mew  F

ID = | Metwork Azsignment Type Address Load Balancing Custom Propetties

0 Infaklox AT Static P e
Maximum network adapters: Unlirited $ (i ]

Save Finish Cancel
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14. Switch to the Properties -> Property Groups tab and click Add.

No data to display

View Merged Properties | @

Web
General  Build Information Machine Resources  Storage  Network  Security  Properties
Property Groups  Custom Properties
- =4 Move D D.fz = |x:_ -
Diescription

Save || Finish || Cancel |
15. Select your Infoblox property group and click OK.
Add Property Groups X
[F] | Name ~ Description
Container host properties with ¢ ertific ate authe Sampile property group with custom properties for container host using certific ate and private key
Container host properties weh user/password Sampie property group with ¢ ustom properties for container host USINg user and password credent
[@] infobiox-Defoue Infoblox Defaut Property Group
{4 4| Page |1 ot » ¥ | @ Displaying 1-30f3
OK Cancel
16. Click Finish.
Web
General  Build Information  Machine Resources =~ Storage  Network — Security ~ Properties
Property Groups Custom Properties
e =) Move D D iew Properies | X Remove
Descripticn
Infoblox-Default Infoblex Default Property Group
View Merged Properties | @
Save || Finish || Cancel |
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Machine Blueprints must be published before they can be used. The steps in this section apply for all Machine
Blueprint types, including for Machine Blueprints documented in later sections in this guide.

1. Navigate to Design -> Blueprints.

2. Click on the row for the blueprint that you want to publish (taking care not to click on the
hyperlinked name for the blueprint).

3. Click Publish.

Hatme i ol Design

Blueprints

Create and manage blueprints. Publish & blueprint to allow srchitects to reuse your blueprint, and to allow catalog administrators to entitle users to request your
bluegrint from the catalog

Blueprints

Software Components

4 N.. & E. “_] B | 1] Fuslli, X Dele...

Mame Crezcription Statuz Last Modified =
Haas 3

Infioblos Wb MAT 1-Many Dratt B/2/2017, 2:44:58 PM

Infioblos et MAT 1-1 Fublished 6/2/2017, 2:33:00 FM

b Infoblos: External 1?2.28.l Infablos ifeb HAT 1-hdany Fublizhed G207, 2:02:21 M

Wieb VMware External 172.26.1.... Fublished Er972017, 1:50:20 PM

4. Verify that the status for the blueprint shows as Published.

Elueprints

Create and manage hlueprints. Publish a blueprint to allowe architects to reuse your blueprint, and to allow catalog administrators to
entitle users to reguest wour blueprint from the catalog.

ap Mew & Edit _“j Copy @y 0 Lnpublish X Delete

| Mlame ~ ! Description Status Last Modified
Infoblox Web HAT 1-1 Published 6252017, 2:33:00 PK
Infoblox Web HAT 1-Many Published G/52017, 2:44:55 PM
‘Web Infoblox External 172.2.. Publizhed Gr9i2017, 2:08:21 PM
‘Web YMware External 172.... Publizhed Gr92017,1:50:29 P

Add Catalog item to the Service.

1. Navigate to Administration -> Catalog Management -> Catalog Items.
2. Click on the name for your catalog item that you are updating.

Inkioz

¢ Administration CatalOg ftems

Catalog tems are published blueprints, Xaas blueprints, and software components. These blueprints and components are published on the Design tab or using
) the vRealize Automstion AP1. To make & catalog tem available in the service catalog, add the item to a service and then entitle the catalog tem to & business
Services group. Software components can alzo be entitled to enforce approval policies, but they can only be requested az part of & blueprint. If you unpublish & catalog
item, it will no longer be svailable in the service catalog.

Catalog hems Advanced Search ¥
=] J
Actionz
Mame = Status Source Resource Type Scope Appearsin Catalog Senrice De...
Irfoblos: visb HAT 1-1 Fublizhed Blueprint Senice Ceployment Shamed ez dew-zenice
Entitlements Infobl oz Wb NAT 4-han Fublizhed Blueprint Senvice Deployment Shared “faz dewv-senice
ek Infobl o Extea i1?2.28.1.0.f24 Fublizhed Blueprint Senice Ceployment Shamed ez dew-zenice
Wizb Whiware External 172.26.1.0024 Fublizhed Blueprint Senice Leployment Shamed ez dew-zenice
Fage |1 af 1 | = Displaying 1- 4 of 4
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3. Setthe Status dropdown menu to Active and in the Service menu, the service to be used.
4. Click OK.

Configure Catalog ltem

General Entitlements

Hame: Infoblox'Web MAT 1-1
Source: Blueprint Service
Resource type: Deplovment

Description:
Icon: | Browse. .
Recommended size: 100 %100 pixels
Provipw Listview Coatalog view Dretail wiew
; (8
Status: |Actiue hd
Quota: | Unlimited -
Senice: |dev-aenri|:e w

[ New and noteworthy

]2 Cancel

12.1.4 Provision the VM from the Catalog Item

1. Navigate to Catalog.
2. Click on the Request button for your One to One NAT catalog item.

Home Catalog ltems Reguests

Service Catalog

Browse the catalog for services you need.

dev-service (4)

E Infoblox Weh NAT 1-1

© 2017 Infoblox Inc. All rights reserved. Infoblox IPAM Plug-in 4.3.0 for VMware VRA 7.3 Deployment Guide  June 2017 Page 110 of 147



3. Set the parameters under the General and Properties tabs as required.

4. Click Submit.

Horne Catalog lterms Reguests Ihbox Design Adrministration Infrastructure Containers
New Request
< [ wfobloxwebHAT 11 Deployment: Infoblox Web NAT 1-1
o) Web | Properties

Description:
Infoblox Web NAT 1-1

Reason for request:

Deployiments: | 1 c (Select 1-100)
1
Save Submit Cancel

5. Verify that the request has completed successfully.

Catalog tems

Requests

Inbox Design Administration Infrastructure Containers
Request
0 The request has been submitted successfully.
OK

12.2 Create One to Many NAT Profile

9. Inyour VRA tenant, navigate to Infrastructure -> Reservations -> Network Profiles.
10. Click New and select NAT.

vmware vRealize Automation

Home

Catalog

lterns Requests Inbox Design Administration Infrastructure Containers

 Infrastructure Network Profiles

Metwork profiles specify network settings in reservations and blueprints. Metwork profiles ar
Key Pairs

& External Type
B nat
& Routed

Reserations
Reservation Policies

Network Profiles
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11. Complete the fields in the “New Network Profile - NAT” configuration, being sure to set the
IPAM endpoint menu to your Infoblox NIOS IPAM endpoint and NAT type to One-to-Many.

Mew Metwork Profile - MAT

Creste a network profile to manage one of more named ranges of static Pvd network addresses,

DS Metwork Ranges

*Hame: ||Infobloc-External-1 -haney

Description:
IPAM endpoint: ||nfokio: 0
* External network ¥
profile: Infoblox-External-172.26.1 0524 0
“HAT type: | One-to-Many

*Subnet mask:

* Gateway:

2552552550

10.10.20.1

DHCP

(024 Apply Cancel

12. Switch to the DNS tab and enter in your DNS configuration.
13. Switch to the Network Ranges tab.

14. Click New and provide a name, description (optional), Start IP address and End IP.

15. Click OK to save the network range.
16. Click OK to save the network profile.

Mew Network Profile - WAT
Create a netveork profile to manage one or more named ranges of static IPwd network addresses,

General D= Hetwork Ranges IP Addresses

L » E.. ¥ Dele.. | g lmpotfrom CS..
Hame Cezcription Start IP = End IF
range 10.10.20.2 10.10.20.20
Ok Cancel
Ok Apply Cancel
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The Machine Blueprint sets the design for instances that are being deployed. This section describes the steps for
creating a blueprint used to create instances in a One to Many NAT configuration.

17. Navigate to Design -> Blueprints.
18. Click + New.
19. Set the General properties for your Single Machine blueprint.

Hew Blueprint
General MZH Settings Propetties

"Hame: | niablax Yieh MAT 1-Many

ID: | infablax ekl AT Mary i ]
Azsign a permanent, unique 10 to this blueprint.

Description:

Deployment limit: el ]
Minimum Maximum
Lease (days): - el i |
*Archive (days): gl |

(8] Cancel
20. Switch to the NSX Settings tab and select the Transport zone to be used. Click OK.

Hew Blueprint
General HSX Settings Propetties

Thesze zettings apply to wSphere machine{?mpunents inthe blueprint that have access to configured MNEX networking and security settings.
Transport zone: |yopsltransport-zone (voerter ~ i

Edge and routed gateway reservation policy: v |

[ App izolation €

Ok Cancel
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21. Here we have the machine blueprint named “Web” and selected machine prefix “prod-*

De[}}gn Canvas

v Sphere_Machine_1

General Build Information
"ID:

Description:

Reservation policy:

Machine prefix:

" Instances:

¥ Web x

_) vSphere Machine

Machine Resources €0 Storage  Metwork
Web

Web VM

[C] Display location on reguest i

prod-

Minimum Maximum

<>

22. Set the Build Information:

Security  Properties

Save Finish

@ Q

Cancel

vSphere_Machine_1

«  General Build Informatio
Blueprint type:
Action:
* Provisioning workflow:
" Clone from:

Customization spec:

n Machine Resources Storage MNetwork
Server

Clone

CloneWorkflow

Linux

Linux

Security Froperties
v 0
L
v 0

23. In the Categories panel, select Network and Security (1).
24. In the bottom left panel, drag the Existing Network button (2) to the Design Canvas (3).
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MNews Blueprint. Infoblox Web 1-Many NAT 48

Categories Design Canvas
[ZE] Machine Types

i Software Components

[ Blueprints 1

|(_“ Hetwamk & Security | Bl
_.5 +a3as

.=_ Containers
anfiguratan dndgemen
[ Configuration Manag t

& Other Components
Search Q

& Container Netwark 2

|ﬁ Existing Metwark

Existing Security Group
Existing Security Tag Y
ﬂ On-Cemand Load Balancer »
Bl onpemand MAT Hetweds L
&% On-Demand Routed Hetuadk \
o On-Demand Security Group '\‘

3

[% Existing_Metwoark_1

@ Q

Fveh

o wEphere [vCente...

Save Finish Cancel
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25. Click on the Existing_Network icon in the Design Canvas (1) and then the selector button for
“Parent network profile” (2).

Mew Blueprint Infoblox Web 1-Many MAT 48

Categories Design Canvas '@,

¢

[ZE] Machine Types
i Software Companents
[ Blueprints ¥ Wik
() Metwark & Security
w Aaas
.:_Containers
|n. Configuration Management

ar Companen ) wEphere [wiente...
% Otherc ts Sph Cent

Search S
@ Existing_Metwork 1%

@ Container Mehuok -
Existing_Hetwork_1

& Ewisting Hetwark
Existing Security Group General @  DHNSWINS P Ranges

Existing Security Tag * Hetwork profile:

@ On-Cremand Load Balanocer

Description:
EL on-Demand HAT Network

Q; On-Lemand Routed Metwad

o On-Demand Security Group

Save Finizh Cancel

26. Select the One to Many NAT network profile created previously and click OK.

Select Hetwork Profile X
Mame Crescription IFAM Endpoint
InfobloxExternal-1-hd any Infobl oz
Infobloss: MAT-1-1 L} Infoblos

2k, Cancel
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Design Canvas @ &

¥ b

wSphere [wCent... %

B InfobloxExternali . * .

InfobloxExternaliMany
General DR=AMIR= P Ranges MAT Fules

*ID: nfohloxExternald hidary

* Parent network profile: |niopioyx-External-1-Many

Description:

IPAM endpoint: Infoklox

External network Infoblox-External-172 261 0524
profile:

HAT type: One-to-Many
Subnet mask: 25323525310

"Gatewayw: 1010204

Save Fimizh Cancel

27. Click on the icon for your machine in the Design Canvas and switch to the Network tab.

28. Click + New.

29. Expand the dropdown menu under the Network column and select your One to Many Nat network
profile.

30. Click OK.
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Design Canvas

v iish x

wSphere [wCent...

EL InfobloxExternall b, .

Web

General Build Infarmation hMachine Rezources Ztorage Hetwork Security Properties Profiles

# E..
10 = Metwak Assignment Type Address Load Balancing
u] InfobloxExternaldbany @StaticlP
Ok Cancel
ImfakloxExternall Many
Maximum network adapters: Unlirmited o [

Save Firizh

31. Switch to the Properties -> Property Groups tab and click Add.

Web

General Build Information Machine Resources Storage Network Security Properties

Property Groups = Custom Properties

Name Diescription

[£] View Merged Properties i )

32. Select your Infoblox property group and click OK.
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Add Property Groups

[F] | Name Description

] Container host properties with certific ate authe Sampie property group with custom properties for container host using certific ate and prvate key f

[7] Container host properties weh user/password Sampie property group with ¢ ustom properties for container host USIng user and password credent

Infoblox-Default Infoblox Defaul Propearty Group

4 4 | Page |1 of1| » ¥ & Displaying 1-30f3
OK Cancel
33. Click Finish.

Web
General Build Information Machine Resources Storage Metwork Security Properties

Property Groups  Custom Properties

= Ei | x
Description
Infoblox-Default Infoblox Default Property Group
View Merged Properties | @)
Save Finish Cancel

12.2.2 Provision the VM from the Catalog Item

6.
7.

8.
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Navigate to Catalog.

Click on the Request button for your One to Many NAT catalog item.

Harme ltems

Service Catalog

Brovwese the catalog for services waou need.

dev-zervice (4)

g Infoblox Web HAT 1-1

Reguests

On behalf of:

Imbnoc Design Adminiztration

Infraztr.

devadmin@ysphere local

Search

g Infoblox Web HAT 1-Many

="

Set the parameters under the General and Properties tabs as required.
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9. Click Submit.

Home = = = Inkac Design Administration fra LIFE Containers

MNew Reguest

4[] Infoblox Y=b NAT 1-Many Deployment: Infoblox Web MAT 1-hary

) Veb General  Properties

Description:

Infoblox Web HAT 1-Many

Reason for request:

Deployments: | 1 o (Select 1-100)

Save | Subimit Cancel

10. Verify that the request has completed successfully.

Catalog ltems Requests Inbox Design Administration Infrastructure Containers

Request

0 The request has been submitted successfully.

OK

12.3 IP Address Provisioning and DNS Registration

The Infoblox Plugin for VMware performs IP address assignment with NIOS. This process includes the
creation of a new Network View (if one does not already exist) to support the network for the NAT,
along with any Fixed Addresses and the corresponding DNS record for the VM instance.

To review the new Network View created for the external NAT network and IPAM details for your VM:

1. Inyour Grid Manager GUI, navigate to Administration -> Network Views and review the Network
Views which are present.

© 2017 Infoblox Inc. All rights reserved. Infoblox IPAM Plug-in 4.3.0 for VMware VRA 7.3 Deployment Guide  June 2017 Page 120 of 147



InrDblox ::" Dashboards Data Management Cloud Smart Folders Grid Administration

CONTROL YOUR METWORE

Hetwork Views Siiy 5 Cloud Authentic

Show Filter

] % default Mon-clowd  Grid
O % vRA-b7 477264 aaf3-Ib39-bbfe-997424527dff  Mon-cloud Grid Automatically crested on-demand network view

2. Totoggle between Network Views, switch to the Data Management tab and click on the dropdown
menu near the top-left of your Grid Manager GUI window.

Inroblox ::‘ Dashboards Data Management Cloud Smart Folders Grid Administration

CONTROL YOUR WE TWORR

DS File Distribution

3. Under the Data Management -> IPAM or DHCP tabs, open the network used for your VM instance
and verify the IP address which was allocated to that VM.

|nf0b|0)( ::‘ Dashboards Data Management Smart Folders

CONTRGL YCUR RETWORK

Grid Administration

IPAM Home

172.26.1.0/24 = wv

Quick Fitter | None M ‘ m Show Filter
Goto Go
‘ ] IP Address « DHCP Cliert dent...  Status

[ % 172.26.1.0 Used 1Prvd hetwork

K- 172.26.1.1 pfsense.ga.com Used Host DNS
[ %% 172.26.1.2 nias qa.com Used A Record DHE
O %% 172.26.1.3 edge-infoblo:caebnat-041530chS-d2c. . Used IPv4 Reservation DHCP
[ %% 172.26.1.4 dev-04.gqa.com ‘ 00:50:56:99:h3 b4 Used Host DS
I - ) 172.26.1.5 YCSE.08.00M Used Host DHS

4. The Infoblox plugin for VMware also registers the VM in DNS. To review this, navigate to Data

Management -> DNS, open the zone used for the network the VM was created in and locate the
DNS record that was created.
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Inrnblox ' - Dashboards Data Management Cloud Smart Folders Grid Administration
CONTROL YOUR RETWORS

=fault

default
ga.com  Authortative Zone (@ P

I Records

Gick Fiter | Mone Show Filter 'E= Toqgqle flat view

Goto Ga
IrCe
[ % MZ Record M £48.Cam System
[ % S04 Recard Serial 1 System
MrAWE nios .Ca.com
RMAKE pleaze_set_email
Refresh 10500
Retry 3600
E:xpire 2419200

Megative Caching TTL 900

[ % compute-1 Host 172.26.1.200 Static
O % dev-04 Host 172261 4 Static

Events executed by the plugin are also captured in the NIOS audit logs. To view these, navigate to
Administration -> Logs -> Audit Log. Filters can be used to simplify the view here.

Dashboards Data Management Cloud Smart Folders Grid Administration

triutes Clauel

Audit Log Log Viewsr G

Guick Fiter | Nane v || [BE] Fitter ot Hide Fitter

Togale single line view

\ a4l
|T\mas15mpA

2017-06-08 14:44:34 PDT  wmeware CREATED Network Yiew VRA-B7471264-8af3-4h39-befe-  Mormal extensible_stiributes: to=[name Viware Blusprint Request ID value 04180chS-d208-40d3-89he 560532952205 name Vitware Network Prafile ID value
997424527t b7 30B679-981-4375-5hG3-67 cehBass143 name Viwars On-Demand Netwark value True name hiwars Reguest D value b7 471264-a513-4h39-bfe-
9974215270ff] commert to=Automatically crested an-demand network view name: to=vRA-h7471264-aaf3-4h39-bAfe-997 42527

2017-06-08 14:4439 FDT  vimware CREATED P Wetvvark 101010024 Harmal TiEtwark_Wisw=yRA-L7471264-5513-4h30-HETe-GATAS 2T edenside_stributes: to=iname Viware Blusirint Reguest ID vale 04160chS-1208-4003-69he-
SG0SIZIB2205 riame Yware Netwark Profil D valus b7 3086 79-29e1-4375-506 3-07 CebBa59143 name Whveare On-Demand Metwork value T name
by Request ID value b7471254-5af3-4739-61e-9974 21527 ] adtress: 10=10,10.1 0.0 Sick: 10=24 comment to=Automatically crested on-demand network
comman_properties: domain_neme to=ga.com domain_name_servers to=[acdress 10.102 3.10] aptions ta=[name domain-search space DHCP cade 119 valuz

i o] routers tosfauchess 10101011 use_broaicast_adeess to=felse use_tomsin_nerme tostue use_domsin_name,servers tosue use._sase fine
to=talse use_options to=true use_routers to=true netvvork_view: VRA-BT4TI254-5a 13-4k restart_if_needed: to=Talse

2017-06-08 14:44:34 PDT  vrnware CREATED IPvd Reserved  1040.10.2-10.10.40.20 Hormal network_vigw=yRA-b747(264-aa13-4b39-b61e-097A2M52Teit: exdensible_sttribules: to=[name \iMware Blugprint Request ID value 04180ch5-d208-40d3-89be-
Range SG0S32962205 riame Wivvare External Network Frofie [ valus Ga3ad524-8d0s-4o56-blef-32637h051 e name Whivare Network Profile ID valus b7 306679
8. 4375-5h63-07 cebBa53143 name ‘Whveare On-Demand Metwork value True name Yhbware Request ID valus b7471264-aaf3-4h39-hife-9874215270f]
COMMErt: to=Automatically Crested on-tiemant FAnge Cammon_propenties: domain_Tame to=s com tomain_Tiame _servers to=ladtress 10.102.3.10] aptions to=
[name clomain-search space DHCP code 119 value "om.com'] routers to=[address 10.10.10.1] use_kroadcast_sdoress to=taise Lse_tomain_name ta=trye
usE_tomain_Tiame_servers to=trus use_lsase time to=talse Use_options to=trus use_routers to=true disabled: to=talse end_address: 19=10.10.10.20
netwark_uisw: Mebwork\iew vRA-57471264-aa13-4h39-hEfe-0742452TdN restart_it_needed: to=false stat_acdress: to=1010.10.2

2017-06-08 14:46:22 PDT  wmwvare MODIFIED IPwd Reserved 1040.10.2-10.10.1020 Hormal network_view=yRA-h7471264-aa13-4b30-bB1e-9974 2527 dff: exensible_sttributes: from={] ta=[name Vidware External Range ID value
Range networkidefaultil 7226 1 0/24] restart_if_needed: to=fakse

2017-06-08 14:4T03PDT  wmeware CREATED IPv4 Reservation  1010.10.2 Hormal network_vigmw=vRa-h747f264-aaf3-4b30-hB1e-9974 24527 dff: exensible_sttribues: to=[name Viware NIC index value 0 name htware On-Demand Network
value True name Yhware resource D valus 138ac7h0-61e5-4378-a158-06M c8265137] commert: ip_address: 10=10.10.10.2 mac_address:
+0=00:00:00:00:00:00 match_option: to=MAC_ADORESS name: to=dev-04 ga.com network _view: Network'fiew vRA-h7471264-aai3-b39-hbfe-997 4 2527aff
restart_if_nesded: to=false
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12.4 De-provisioning

De-provisioning the machine will release the IP address and DNS record

Deployments
Select an item type from the menu on the leftto view your provisioned items. Use the Actions menu to manage your items.
\iew Details D iew Parent Dstails f& \iew Components | -@Acuons -
Name Description ¢ %! Change Lease Cost to Date
* [} infoblox-Single-Web-950( Prod demo #1 f % Change Owner Not Appc sble
© Destroy
@) Expire
J Scaleln
2 Scale Out

Destroy - Infoblox-Single -Web-95005831

e Destroys a deployment and all constituent resources.

Are you sure you wish to continue?

Submit Cancel

Release workflow of Infoblox Plugin gets called which releases the IP address and removes the DNS
record
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vmware vRealize Orchestrator~ [

Schema ‘ Events

@B 58|

Release

¥ L2l achministrator @ vraT3.0m.com
¥ ] Library
b Camar
v [T AMGP Samples
» Cazure
» [ Configuration
» [ Data Managemert
» [CDats Managemsnt Samples
» [l Dynamic Types
» CHTTR-REST
» [IHTTP-REST Samples
¥ [infablox
v Cwra
» [ administration
» [ Configuration
» [Helpers
» [ installation
» B allocate
Creste Endpoint Connection
» B3 Creste P Ranges
Delete IP Ranges

=

Validate inputs Create Endpoint Con

Error handing

=L

Log resource proper

Get resource proper

Get custom propert

» EJ Gt adoress spaces

» B3 Get IP Ranges
v Ed Release

General  Variables | Logs

[ 7 X & = |inio v

: Messages
Add network Nichndor: 0

Add range [2017-06-09 14:31:25.217] [I] Release External, Routed started.
femove DHCP record [2017-06-09 14:31:25.220] [I] Got workflow parameters:
Removs DNS racord ipamConnection ID: 33b3cle20-chea-4ae-b01 5-45fBeb725ccT
Remove host record removeHostRecord: true

Remove network removeAddressRecord: false

- removeAddressAndPtrRecords: false

Remove range removeFixedAddress: false

Reserve IP address
Reserve IP in network
Reserve IP in range
Restart IPAM services

removeReservation: false
resourceld: alc63737-720b-40a2-bf55-1 a1 03827440
vricdex: 0
[2017-06-09 14:31:25.353] [1] Releasing P addresses allocated for NIC #0
[2017-06-09 14:31:25.467] [1] Infoblox IPAM connection: mios ga.com

» Cuose [2017-06-09 14:31:25.803] [1] Searching for host records by specified extensible atributes:
» [Lacking hiware resource ID EQUAL "a0c63737-729h-40a2-hf55-1a1 043927 4cl0"

» Emsi Whiware NIC index EQUAL "0"

» EdMicrosoft [2:11:;49 14:3,:‘:zrs.n:s1 1] The following host records were found

> [hsx lev-03.ga.comidefaul

[2017-06-09 14:31:26.228] [I] The host record [dev-03.ga.comltiefaut] was removed from PAM
[2017-06-09 14:31:26.395] [I] Finished releasing IP addresses allocated for NIC #0.
[2017-06-09 14:31:26.889] [I] Release resut:
ReleaseRequestid 45fe29a8-3f38-492e-ae46-05419fd01 Tae
Status: Completed
ErrorCods
|-

» [ Orchestrator

> [ Pawsrshel

» CIRPPravisionCAC
» CIRPTestlenkins

» [ smme

L4

T

13. Custom Hostnaming Extension

The Custom Hostnaming Extension can be used to change the VM hostname during provisioning. The
Custom Hostnaming Extension works with other third party custom hostnaming extensions and can be

downloaded using the following URL:

https://github.com/dailyhypervisor/custom-hostname

13.1 Import the Package

Before the extension can be installed in vVRA, it must be imported in VRO as a package. To import the

package:
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https://github.com/dailyhypervisor/custom-hostname
https://github.com/dailyhypervisor/custom-hostname

1. In Design mode, switch to the Packages panel and click on the Import Packages button.

© Whneare wRealize Orchestrator - administrator @ wra¥3.qa.com - [Server] |2 E

vmware' vRealize” Orchestrator | Tools * | Help ~| (QSCEERCY -

com.infoblox.integrated.ipam

E ;1!} @ L&|Q ||_# J Imponpackage...s Policy Templates  Actions  Configurations  Resources  Used Plug-Ins  Permissions

L-J comm.infoblox integrated ipam

L-J com.infoblox ipam

L-J ot ymware library
| hama cam infahlov intanratad inam |

2. Browse to and select the .package file for the Custom Hostnaming Extension. Click Open.

L fOpen @

Loak In: lﬁ custom-hostnarme-rm... '] ' [ | ot || ] ' i% E

| j cam.vmware. sdesetyra.customhosthame.package |

|| README md
File Mame: cam.vmware. sdesetyra.customhosthame.package
Files o Type: | All Files v

. Cancel .

3. Click Import and trust provider (or Import Once).

Import package.. @

Package Import Information

- The package owners certificate is not yet known I
- The owner cerificate is nat trusted

VRO dhmtvra.dailyhypervisor.local

38202966-5981-4e25-8276-dca8114eal04
Organization : YMware
Qrganizational Unit : Unknown
Country
Fuhlic key : RSA
Serial Murnber : 15 84 14 C3 -

Commaon Mame (6 characters min)

Do you wwant ta import this package and s associsted cerificstes 7

| cancal | { Import Once J [ lmportandlruslprowdernl
ki
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4. Click Import selected elements.

Note: Not all items may be selected due to version compatibility or other issues.

 Import package.,
[ com vmware sdeset.vra.customhastname

C:'Downloads\custom-hostname-mastericom.vmware sdeset.vra.customhostname package

File elemerit File Path vRO Server elements Server Path
@ Set custom hostname - State Transition <.0.1 whiware/SDE-SETARealize Automation/Custom Hos... B @ .
(] B2 replacevidualiachine i ing... com.dai isorura.common = [EN]
(V] B2 1ockiotdlomandivait 0.0.0 com.dailyhyperiser.common = [N
(V] €82 unlockiorktlon0.0.0 com. dailyhypenizor.comman = [N
(V] [ vRA Envitenment Configuration 1.0.1 CailyhyperisorvRealize Autemation/Commen = [N
(] B3 install custom hostname 4.00 Whdware/SDE-SETARealize Automation/Custem Hos... B @
(] B3 install state change waordlaw 3.0,0 Wi DE-SET/C Install = &N
(/] B create property group 20.0 Wb DE-SETIC Install =] [N
() ¥ satConfigurationElementattribute 1.0.1 com.dailyhyperiser.common = &l
= Elementwill be imported. =) Elerment allowed for import, but not imparted
= Unable to import, server version is greater or a new branch has been created in the serverversion. 2% Unable to overwrite a non-encrypted element with an encrypted one.
8 Locked orinsufficient access rights. A\ version nat incremented element

] selectDeselect all
E] Importthe values of the configuration settings

|Importtags but preserve existing values YJ

l Cancel J [ Import selected elements n]

%)

5. Verify that the package for the Custom Hostnaming Extension imported successfully.

© Vhware vRealize Orchestrator - administrator @ wrald.qa.com - [Server]

vmware vRealize® Orchestrator

7 com.vmware.sdeset.vra.customhostname
E l...\_; @ Ld ‘ D ||_# J General |Workﬂows Palicy Templates  Actions  Configurations  Resources  Used Plug-ins  Permissions
LJ com vmware libkary n
LJ com vmware libkary amop
-
LJ com vmware libkary azure
MName comvmware.sdesetvra.customhostname

LJ com wmware libkary contiguration
[ com wmware liorary datamanagement Legal owner vRO dhmdtvra.dailyhypenvisorlocal 38202966-5981-4825-8276-dcad144ea404
LJ com.ymware library hitp-rest

Global tags
LJ com.vmware library locking
LJ com.ymware library mail Usertags
u com vmware library microsoft
u com ymware library poveershel
u com vmware library poweershell.converter
u COMm . ymvare library Snmgp

Description

u com vmare library Soap
u com.ymware library sol

u com vimware library ssh

LJ com vmware libkary tagoing

LJ com vmware libkary vapl

LJ com vmware libkary voac devops rp

[=) com vmware forary voenter

LJ com.ymware library yoo managemert

LJ com.ymware library yra cafe

LJ com.ymware library vra isas

u com.ymware library widocs

u COm vmware library xml

[ comumuware nsx

u com ymware .ol Tn.plugin dynamictypes

u com ymware 0110 pluging . devops pp.rp-provision-yoac
u com ymware .01 1n.pluging. devops rp.rp-test-ienking
u com ymvware .01 1n.pluging. devops pp tfs

LJ com vmware 0l1n pluging devops rpovra

LJ com vmware sdeset wra customhostname I,\\,

|1 comvmware util
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13.2 Install the Custom Hostnaming Extension in VRA

To complete the installation for the Custom Hostnaming Extension in VRA:

1. In Design mode, switch to the Workflows panel and drill down to VMware -> SDE-SET ->

vRealize Automation -> Custom Hostname -> Configuration.

2. Select “Install custom hostname” and click on the Start workflow button.

© ‘WMware vRealize Orchestratar - administratar @ wral3qa.com - [Server]

vmware vRealize” Orchestrator | Toois ~| Her

= |

LY

[=lo ==

Search for

%] - = Install custom hostname
J E-‘] | 1‘!; |§] |_.d. g L# rs References Warkflow Tokens Events Permissions
¥ o) administrator @ vra?3.ga.com J General | Inputs Qutputs Schema Presentation
[ DL\brary
» [ system —
¥ [ vhtweare Resume from failed behavior  Systermn default |
¥ [ SDE-SET
» [ Commen Global tags
¥ [ vRealizs Automation Usertags
¥ [ custom Hostriame:
¥ [ configuration Install the custom hostname extension into the BuildingMachine state
3. Click on the Not set link under vRealize Automation catalog host.
© Start Workflow : Install custorn hostname E
vRealize Automation catalog host
(% Not set
vRealize Atﬂﬂﬁ WCACCAFE ¥CACHOS
(% Notset
Cancel Submit
4. Select your VRA catalog host. Click on the Select button.
© Select {wCACCAFENCACHast ) [==2a]
VCACHost - vsphere.local[configurationadmin@vsphere.local]-wr...
J L# | J General ‘ Custom properies
v @vRealize Autamation
b @ Default [hitpsivra?3.ga. here local
. efaull [fitps: fura7 3 ga.com] [vsp ?r? ol Last updated - 26 seconds ago.
» # TenantCafeHost[vaphere local][Administrator][Per L -
e |ocal[configurationadimi ~ Tags 4
” Globaltags
Usertags
username configurationadmin@vsphere.local
b
v
Ll httneifra? na rom |
[« F L m't F IO

Cancel
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5. Click on the Not set link under vRealize Automation laaS host.

o StartWorkflow : Install custom hostname X

Common parameters
vRealize Automation catalog host

% vsphere.local[configurationadmini@vsphere.locall-vra73.qa.com [hitps:ivra73.ga....

vRealize Automation laaS host

% Mot set ‘h
wCACWCACHDSt

Cancel Submit

6. Select your Infoblox laaS server. Click on the Select button.

© Select (WCACHCACHDst ) (=]
VCACHost - Infoblox laa$ [https://w2012vm.qa.com/]

J I_ﬂl' | J General ‘ Custom properties

v '@ vRealize Automation Infrastructure

|
b @ Infrastucture - w201 2vm ga.com [https: o201 2vm

Last updated - 8 seconds ago.

~ Tags _"
Glohaltags
Usertags
-
url https:fiw2012vm.ga.com/
name Infoblox laas
- . — | id 4687260-d5h0-42h2-9a6d-ac4a026a7694
= T i [ abd-ac4al26a |v
Cancel . Selectg.
7. Click Submit.
o Start Warkflow ! Install custom haosthame @

Common parameters
vRealize Automation catalog host

% vspherelocallconfigurationadmin@vsphere locall-vray3.ga.com [hitps:iira73.ga....

vRealize Automation laaS host
% Infoblox laas [hitps:iw201 2vm.ga.com/]

| cancel | [ Submit{l_")
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8. Verify that the extension installed successfully.

© Whtware vRealize Orchestrator - administrator @ vrald.qa.corm - [Server] E’E

| Toals " Help '|

vmware vRealize* Orchestrator- G

Install custom hostname

[
G} E&,) C, E |_# J Schema | Events
v E administrator @ vra73.qa.com
s EILibrary Install custom hostname
[ Dsystem
¥ Clvmware Pl
¥ [JsDE-SET
» [l common
¥ [l vRealize Automation e _— . B {B E— {g e @
¥ [ custom Hostname
vy Configuration Install state chang setConfigurationEle setConfigurationEle ¥

v Install custom hostname
Install custol ame [0
Set custom hostname -

General | Variables  Logs

Mame - Install custom hostname

I - 308081 Scehd382015d025196a401d4

Business status - completed
‘Wiorkflowe - Install custom hostname
State - completed
Start date - 01:01:27

End date - 01:01:30

9. InVRA, navigate to Administration -> Property Dictionary -> Property Groups.
10. Verify that the Custom host name property groups are now available.

Haoime Catalog Inbac Design Acdministration Infr sstructure Cortainers
S —— Froperty Groups
¢« &dministration p m"f p
Create and manage property groups
Property Defintions N S X
Hame = 10 [rezcription Wigibility
Property Groups Cortainer host properties with o... ContainerHostProperiesWithCertif...  Sample property group with custe... All tenants
Cortainer host properties with u...  ContainerHostFropediesfithFasan... Sample property group with costo... Al tenants
Infobl ox- Default Infoblo:Default Infoblox Default Property Group All tenants

Component Profiles

13.3 Duplicate the Property Group

As a best practice, create a copy of the Property group and make any modifications to the copy, leaving
the original intact so that future copies can be made and used without being impacted by unexpected

changes. To make the copy:
1. InvRA, navigate to Administration -> Property Dictionary -> Property Groups.
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2. Select the row for the property group (do not click on the link) and click Copy.

Home d Aclministration
Property Groups
¢ Adminiztration p rty p
Create and manage property groups
Froperty Definttions N FE. ||:E Co.{}_ny X Dele..
Mame = 1)
Property Groups Cortziner host properties with o, ContainerHostP ropertiesiliith Certif....

Container host properties withu...

i Infablox-Default
Componert Profiles

ContainerHostP ropertiesiiith P asan...

Infoblox-Default

Dezoription

Sample property group with custo...
Sample property group with custo...

Infablox Default Property Group

Wisibility

All tenants
All tenants
All tenants

3.
Property Groups
Create and manage property groups
4k New 7 ] »
MName

20170109222233 Custom Hostname Properties Template
Container host properties with certificate authentication

Container host properties with user/password authentication

Infoblox-Default

dgb New 7 x
Mame

Infoblox . IPAM createHostRec ord
Infoblcx. IPAM.c reateReservation

D

201 701059222233CustomHostnameProperties Template

ContainerHostProperties WithCertific ate

ContainerHostPropertiesWithPassword

Infeblox-Default

Infoblox . IPAM. CustomHostname. ConditionalMac hineCustomProperty 0. Mame

Infobicx. IPAM. CustomHestname. ConditionalMac hineCustomProperty 0. \Value

Infobilcx . IPAM . enableCustomHostname
Infobilcx. IPAM. NetworkD.aliases

Value Encrypted F‘f‘ﬂq":e:‘t
TRUE No MNo -
FALSE Mo Mo
Custom.SetCustomHosina. .. Mo Mo
true Mo Mo
TRUE Mo Mo

Mo Mo i

To avoid conflict with vRealize Automation properties, use a prefix such as a company or feature name followed by a dot for all custom property names.
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Create Property Group

“Name: |Custom Hostname Properties Demo

D: | Custom-Hostnaming-Properties-Demo
Visibility: This tenant

Description: "Proper-iies for Custom Hogmamiﬁg Extension v4

Properties: & New ° | %

Name Value Encrypted m
Custom.SetCustomHostname.Execute true No No A
Custom.Deployment HostnameSc heme No No
Extensibifity Lifec yc le. Properties VMPSMasterWorkflow... * No No
Custom.ComponentMac hine. HostnameScheme No No
Custom.Hostname OwnerShortNameldentifier USR No No
Custom.ComponentMac hine NoindexOnFirst true No No i

To avoid confiict with vRealize Automation properties, use a prefix such as a company or feature name followed by a dot for all custom property names.

Property group has been created.

Property Groups
Create and manage property groups
o New 5 x
MName = 0
20170109222233 Custom Hostname Properties Template 20170108222233CustomHostnameProperties Template
Container host properties with certificate authentication ContainerHeostProperties WithCertific ate
Container host properties with user/password authentication ContainerHostProperties WithPas sword
Custom Hostname Properties Demo Custom-Hostnaming-Properties-Demo
Infoblox-Default Infoblox-Default

13.4 Set the Host name scheme

Set the Host naming scheme in the Property Group
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Edit Property Group: Custom Hostname Properties Demo

*Name: | Custom Hostname Properties Demo
ID: Custom-Hostnaming-Properties-Demo

Visibility: This tenant

Description: |Properties for Custom Hostnaming Extension v4

Properties: & 1oy & Edit | 3 Dot

Show in
Name “value Encrypted A t
Custom.Ueployment.Hostname ¢ heme No No ",
Extensibility. Lifec yc le.Properties \"MPSMasterWorkflow... * No No
Custom.Compenentiac hine. HostnameSc heme v | (LOCHGREHAPP) s |
Custom.Hostname. Uwnershorthameldenther No No

| ©OK || Cancel |

Custom.CempenentMac hine. NelndexOnFirst Ne No
Custom.Deployment. Nolndex OnFirst true No Mo -

To avoid conflict with vRealize Automation properties, use a prefix such as a company or feature name followed by a dot for all custom property names.

Edit Property Group: Custom Hostname Properties Demo

“Name: }Custom Hostname Properties Demo

D: Custom-Hostnaming-Properties-Demo

Visibility: This tenant

Description: |Properties for Custom Hostnaming Extension v4

Properties: + New & Edit [ R Delete

Name Value Encrypted m
Custom.Ueploy ment. HostnameScheme No No 2
Extensibility. Lifec ycle. Properties. V\MPSMasterWorkflow... * No No
Custom.ComponentMac hine.HostnameSc heme {LOCHGRPHAPP}{###) No No
Custom.Hostname.OwnerShortNameldentifier USR No No
Custom.ComponentMac hine. NolndexOnFirst true No No
Custom.Depiloyment NoindexOnFirst true No No -

To avoid confiict with vRealize Automation properties, use a prefix such as a company or feature name followed by a dot for all custom property names
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13.5 Create the LOC custom property

Create the LOC custom property in vSphere Endpoint. Make sure there is no space in the value as
DNS records can’t have a space in them.

Edit Endpoint - vSphere (vCenter)
Manage a specific endpoint.

General

*Name: | vCenter

Description:

Address: httpsi//ivcsa.poc.infobloxdemo.com/sdk
*Credentials: vCenter
¥ Specify manager for network and security platform
*Address: | https://nsxmgr.poc.infobloxdemo.com

*Credentials: NSX creds

Custom properties: = o New  Edit X Delete

Name ~  \alue Encrypted
LOC SantaClara No

To avoid confiict with vRealize Automation properties, use a prefix such as a company or feature name followed by a dot for
all custom property names
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13.6 Create a GRP custom property in Business Group

Create GRP custom property in the business group
Edit Business Group: local-business-group
General Members  Infrastructure

"Mame: |local-business-group

Description:

* Send manager emails to: | vraadmin@vsphere.local

Active Directory Policy | Mo policy selected

Custom properties:

W & x
MName Value
GRP Local

Save || Cancel

13.7 Create APP Property in the VM Blue print

Create a Blue print in vVRA

w ‘Web

) viphere Machine

& LocalinfobloxExter. .. l

Add Infoblox and Custom Host name property groups
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Web
General Build Information Machine Resources  Storage Network  Security Properties

Property Groups  Custom Properties

& Add =¥ =4 = s | R

Name Description

infoblox-Default Infoblox Default Property Group

Custom Hostname Properties Template demo Properties for Custom Hostnaming Extension v4

Add APP custom property

Web

General Build Information Machine Resources Storage Metwork — Security Properties

FProperty Groups Custom Properties

% New 7 x

; Show in
Mame Yalue « Encrypted = Owverridable = t
APP Web Mo Yes Mo

13.8 Deploy VM

Deploy VM

fems Requests Inbaox Design Administration Infrastructure Containers

Service Catalog

Browse the catalog for services you need.

Local-Service (1)

Infoblox-Simple-Web
local-business-group
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VM has the custom host name properties

vSphere Machine: Web

General Storage Properties
o New F Edi | X
Mame alue

Infoblox. IPAM. CustomHestname. Conditionaliac hineCus tomProperty 0. Name
Infobilee. IPAM. NetweorkD.dns\View

Custom. Deployment. HostnameSc heme

Infobiox . IPAM.c reateAddressRec ord

Infobiox . IPAM.Network 0.c omment

Infoblox . IPAM.Network 0.ms Dhe pServer

Infobloo . IP&M.c reateRes envation

Infolblox. IPAM. Network 0. aliases

Custom. SetCustomHostname. Execute

Infeblox. IPAM.Netweork D.enableDhe p

Infobie:x . IPAM.c reateFinedAddress

Infobiox . IPAM.c reateHostRecord

ExternalF Stubs . Mac hineProvisioned

GRP

Infoblox . IP&M createfddressAndPirRecords

Custom. Deployment. NolndexOnFirst

Infoblox. IPAM. restartlMNeeded

Infoblox. IPAM.enableCustomHestname

Infoblox IPAM. CustomHostname ConditicnalMac hineCustomProperty 0. Value
Custom.Hostname. OwnerShorthameldentifier

Custom. ComponentMac hine. Hos tname Sc heme

Extensibility. Lifec ycle. Properties . "MPSMasterWorkflow 32 Requested
Custom. ComponentMac hine. NolndexOnFirst

Infobilox. IP&M. Network D.enableDns

APR
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Custom. SetCustomHostname. Exec ute

FALSE

FALSE

true
FALSE
FALSE
TRUE

T12H2H72-T01d-455a-84f5-4bbec OcbdSc o

loc al
FALSE

FALSE
TRUE
true
USR

{LOCHGRPHAPP}{###)
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VRA issues request to Infoblox Plugin to allocate IP address and to do DNS registration. vVRA passes
the machine name based on prefix, Infoblox Plugin allocates the address and registers the name in
DNS.

Below we can see that VRA has obtained the IP address 172.26.1.4 for local-03.prod.com VM from
Infoblox NIOS

DMNS File Distribvsticn

IPAM Home
172.26.1.0/24 = PvaNetwork  #r Goto DHCP View

Quick Filter | Maone v | O | Show Filter
Go to Go
_ IP Address Name MAC Address DHCP Client Ide....
& 172.26.1.0
M & 172.26.1.1 Router Reservation
[ - ; 172.26.1.2 nios . poc infobloxdemo.com
] £ 172.26.1.3 pfsense.poc infobloxdemo.com
] % 172.26.1.4 loc al-03.prod.com

Infoblox Plugin has created DNS record in Prod.com for the VM
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1L}  File Distribution

Zones Members Name Server Groups Shared Record Groups
default
prod.com Authoritative Zone il / L

Quick Filter | None

Bilac kiist Rulesets

DMNSE64 Groups Query Monitoring

| showFilter g Tonale fiat view

Go to Go
[ MName « Type Data Record Source Principal
[ % SOA Record Serial 55 System
MMAME nics . pod infoblox:
RMAME please_set_email
Refresh 10800
Retry 3600
Expire 2415200
MNegative Caching TTL S00
[ NS Record nios.poc infobloxdemo.com System
] & loc ak-03 Host 172.26.1.4 Static

VM has been created in vSphere

=l @ vesa, poc. infobloxdema.com
= [ Infoblox
= [l Compute
B compute-1.poc.infobloxdemo.com
([ SantaClaralocalWeb002

© 2017 Infoblox Inc. All rights reserved. Infoblox IPAM Plug-in 4.3.0 for VMware VvRA 7.3 Deployment Guide

June 2017 Page 138 of 147



13.9 Name Update

When Machine Provisioned event happens, Infoblox Plugin workflow “Update IPAM Record” gets
called, it updates the Machine name and IP address.
¥ [ Infoblox
v [ vRA
» (] Administration
» [ Configuration
» [ Helpers
» [ Installation
» E3 Alocate
g Create Endpoint Connection
> Create IP Ranges
> 8 Delete IP Ranges
» BA Get Address Spaces
> Get IP Ranges
> Release
v E3 Update IPAM records

Update IPAM records [15:45:55]

e . ..

Below we can see that name has been changed to santaclaraweb002.prod.com
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Dashboards Data Management Smart Folders Grid Administration

File Distribution

Zones Members Name Server Groups Shared Record Groups Biac kst Rulesets DNSE4 Groups Query Monitoring

default

pI'CId_COI'T'I Authoritative Zone il / G

[ Recoras

Quick Fitter| Mone v | Off | Show Filter ~ Ta Toggle flat view
Go to Go
_ Name = Type Data Record Source  Principal
K - SOA Record Serial 56 System
MMAME nios . poc infoblox¢
RMAME please_set_email
Refresh 10800
Retry 3600
Expire 2419200

Negative Caching TTL S00
NS Record nios.pot .infoblox demo.com System

K -
[ % santac laraloc abweb002 Host 172.26.1.4 Static

Data Management Smart Folders Administration

DNS File Distribution

IPAM Home

172.26.1.0/24 < PvaNetwork # %  Goto DHCP View

Quick Filter | Mone v | Show Filter

Go to Go

_ IP Address ~ Name MAC Address DHCP Client Ide...  Status
] % 172.26.1.0 Used
O £ 172.26.4.1 Router Reservation Used
] % 172.26.1.2 nios poc infobloxdemo.com Used
] % 172.26.1.3 pfsense poc.infobloxdemo.com Used
] % 172.26.1.4 santaclaralocalweb002 prod.com  D0:50:56:8d:67:46 Used
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14.1 Adding Failover Endpoints

End points can be added for high availability. NIOS will try the endpoints in the configured priority order.
This section describes how to add the endpoints.

Edit Endpoint - Infoblox

Manage an endpoint for a third-party IPAM solution provider plug-in that you have registered invRealize Qrchestrator,

General

*Hame:

Description:

* Address:
*User name:

*Password:

Custom properties:
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MID5-1

Infoklox Endpoint

hitpsifnios fest.com

cloudadmin

4k Mew

& Edit 3 Delete
Marme

Infoklox IPAM APIType
Infoblox IPAK Endpoint1 Hostname
Infoblox IPAM Endpoint1 Password
Infoblox IPAM Endpoint1 Priority
Infoblox IPAM Endpoint1 Username
Infoblox IPARM Endpoint2 Hostname
Infoblox IPAM Endpoint2 Password
Infoblo:x IPARM Endpoirt2 Priority
Infoblox IPAK Endpoint2 Username
Infoblox IPAM Endpoint3 Hostname
Infoblox IPAM Endpoint3 Password
Infoblox IPAM Endpoint3 Priority
Infoblox IPAM Endpaoint3 Username

Yalue

Cloud &P

172261 .3

ERERRERRRERS

1

cloudapi

httpz: fnios demo.com
ERERRERARARS

2

cloudagi

https: fnios poc infobloxdemo com
T —

3

cloudadmin

Encrypted
Mo
Mo
Yes
Mo
Mo
Mo
Yes
Mo
Mo
Mo
Yes
Mo
Mo

To avaid conflict with vRealize Automation properies, use a prefix such as a company or feature name folloveed by a dot
far all custom property names.

June 2017 Page 141 of 147



14.2 Limiting the Search Results

Search results can be limited by specifying the search result count in Custom properties or at the time

of search

Search Result count can be specified in the custom property

General

*Name:

Description:

*Address:
*User name:

* Password:

Custom properties:

Edit Endpoint - Infoblox

Manage an endpoint for a third-party IPAM solution provider plug-in that you have registered in vRealize Orchestrator,

NIOS

Infoblox Endpoint

hitps:inios.poc.infobloxdemo.com

cloudadmin

* Mame

© @ |Infoblox.IPAM. GetiPRanges maxResults

Infoblox.IPAM.API Ty pe

« | \alue Encrypted
20/ O
Cloud AP| No

Te avoid confiict with vRealize Automation properties, use a prefix such as a company or feature name followed by a dot for

all custom property names.

When a Network Profile is created, it will give the total results as specified in the custom property.
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Select Network Range x
lsearch S ]

[ StartIP ~ End IP MName Description

|:| WARNING Mot all data returned. Use fiters to narrow results. -,
D 11.11.0.1 11.11.0.254 11.11.0.0/24

E| 11.11.1.1 11.11.1.254 11.11.1.0624

E| 11.11.21 11.11.2.254 11.11.2.0/24

E| 11.11.31 11.11.3.254 11.11.3.0124

E| 11.11.41 11.11.4254 11.11.4.0024

E| 11.11.51 11.11.5.254 11.11.5.0024

E| 11.11.6.1 11.11.6.254 11.11.6.0/24

E 11.11.7.1 M.M.7.254 n.1.7.0024

E 11.11.81 1.11.8.254 11.11.8.0/24

E 11.11.81 11.11.9.254 11.11.8.0024

1/ 1111101 1111 10 254 1111 100024 M
|4 4 | Page ‘1_01'1| ook | Displaying 1 - 21 of 21

QK Cancel

14.3 Specifying Search Result Count during Network Profile Creation

14.3.1 Max Results

Parameter max can be used to narrow down the list

Select Network Range %
max=3 o0

[7] | Start P « End IP Name Description

|:| WARNING Mot all data returned. Use fiters to narrow results.

|:| 11.11.01 11.11.0.254 11.11.0.024

|j 11.11.1.1 11.11.1.254 11.11.1.0/24

|j 172.26.1.1 172.26.1.254 172.26.1.0024
4 4 | Page |1 ofi| b bl| @ Displaying 1 - 4 of 4

OK Cancel
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14.3.2 Specifying Max Results and Network

To get the maximum number of results for a particular network:

Select Network Range

] StartiP«

1n.1.0.1
11.11.1.1
1.11.29

OO0

4 | Page |1

max=3 and network=11.*

of 1

End IP

11.11.0.254
11.11.1.254
11.11.2.254

2 0

Name
WARNING
1M.11.0.0024
1M.11.1.0024
M.11.2.0024

Description

Mot all data returned. Use filters to narrow resulis.

Displaying 1 - 4 of 4

OK Cancel

14.3.3 Specifying Max Results and Network wildcard

Wildcard can be used in the address to find a particular network:

Select Network Range

[F] | StartiP «

0

11.11.01

O
[ 1n1111
O
O

11.11.21
11.11.3.1

i | Page |1

max=4 and network=*11*

of 1

End IP

11.11.0.254
11.11.1.254
11.11.2.254
11.11.3.254

0 @
Name
WARNING
11.11.0.0i24
11.11.1.0624
11.11.2.0i24
11.11.3.0424

Description

Not all data returned. Use fiters to narrow results.

Displaying 1- 5 of 5

OK Cancel
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14.3.4 Search Using Regular Expression

Regular Expression can be used for searching

Select Network Range

max=4 and network~="11L12\.* (i ]

]| StartIP « End IP Name

&l WARNING
| 111201 11.12.15.254 11.12.0.0/20
]| 1.12.16.1 11.12.31.254 11.12.16.0/20
F| 112321 11.12.47.254 11.12.32.0/20
] 11.1248.1 11.12.63.254 11.12.48.0/20

| 4 | Page |1 of 1 -

Description

Mot all data returned. Use filters to narrow resulis.

Displaying 1- 5 of 5

OK Cancel

14.3.5 Searching Using Type

Type can be specified as “range” or “network” to get the range or network results respectively.

To search for a range, specify type = range

Select Network Range

max=4 and network~=*11.12\.* and type=range a
[ | StartiP « End IP Name
]| 1112020 11.12.0.100 11.12.0.20 - 11.12.0.100

Description

Displaying 1- 1 of 1

0K Cancel
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To search for network, specify type = network

Select Network Range x
ax=4 and network~="11.121.* and type=network & @
[ StartiP End IP MName Description
|:| WARNING Mot all data returned. Use filters to narmow results.
[ 11.12.0.1 11.12.15.254 11.12.0.0¢20
]| 112161 11.12.31.254 11.12.16.0/20
[ 112321 11.12.47.254 11.12.32.00/20
]| 11.12.481 11.1263.254 11.12.48.0/20
4 4 | Page [1 of1| b bl | @ Displaying 1-5of 5
0K Cancel
14.4 Filtering by Max results, Extensible attributes and Type
EA can be specified in search
- Select Network Range x
max=4 and Building=400 and type=netwaork 990
[]| start P « End IP Name Description
[ 1114 11.11.1.254 11.11.1.0024
[F]| 11.11.15.4 11.11.15.254 11.11.15.0/24
4 4 | Page |1 of1| b bl | Displaying 1 - 2 of 2
OK Cancel
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EA can be tagged with “ea:” as well

Select Network Range x|
max=4 and eaBuilding=400 and type=network & @
Start IP « End IP Name Description
11111 11.11.1.254 11.11.1.0024
11.11.15.1 11.11.15.254 11.11.15.0/24
4 4 | Page |1 of1| b bl | & Displaying 1 - 2 of 2
OK || cancel
If a wrong EA is specified, an error will be displayed.
Select Network Range x|
max=4 and ea:Wireless=400 and type=network & @
Start IP & End IP Name Description
Error The extensible attribute definition with name [Wireless] wa...
4 4 | Page |1 ofl| b bl | & Displaying 1 - 1 of 1
oK || cancel
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